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Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©May 2009

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. pat-
ents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of
this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home
or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineer-
ing or disassembly is prohibited.
Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
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Preface
FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the 
device.
II
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FCC RF Radiation Exposure Statement:
1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This 
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator 
and your body.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
III
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (Full Range AC/DC Adapter - AC Input 100 - 

240V, 50 - 60Hz/ DC Output 19V, 11.6A or 19V, 12.2A (220W) minimum).

This Computer’s Optical Device is a Laser Class 1 Product
IV
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place where 
foreign matter or moisture may 

affect the system.

Don’t use or store the computer 
in a humid environment.

Do not place the computer on 
any surface that will block the 

Vents/Fan Intakes.
V



Preface
3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power until 
you properly shut down all pro-
grams.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
VI
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a 

steady, uninterrupted power supply. If you are unsure of your local power specifications, 
consult your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third 
prong is an important safety feature; do not defeat its purpose. If you do not have access 
to a compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not 
by its wire.

• Make sure the socket and any extension cord(s) you use can support the total current 
load of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power 
supplies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
VII
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
VIII
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
IX
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-

ware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer
from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
X
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
XI
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the 
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a 
footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles when 

you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent and 

short breaks are better than fewer and longer breaks.
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Lighting
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.
XIII



Preface
XIV



Preface
Contents
Notice ................................................................................. I

FCC Statement .............................................................II
FCC RF Radiation Exposure Statement: ................... III
Instructions for Care and Operation ........................... V
Power Safety .............................................................VII
Battery Precautions ................................................. VIII
Cleaning ..................................................................... IX
Servicing .................................................................... IX
Travel Considerations ................................................. X

Quick Start Guide
Overview ........................................................................1-1

Advanced Users ...........................................................1-2
Beginners and Not-So-Advanced Users ......................1-2
Warning Boxes ............................................................1-2
Not Included ................................................................1-3
System Software ..........................................................1-4
RAID & AHCI Setup .................................................1-4

System Startup ...............................................................1-5
System Map: LCD Panel Open & Top View ................1-6

LED Indicators ............................................................1-7
Game Keys ..................................................................1-7

Touch Sensor Instant Keys ............................................1-8

Keyboard ........................................................................1-9
Function Keys & Visual Indicators ...........................1-10

System Map: Front & Rear Views ...............................1-11
System Map: Right View .............................................1-12
System Map: Left View ...............................................1-13
System Map: Bottom View ..........................................1-15
Windows Vista Start Menu & Control Panel ...............1-16
Video Features .............................................................1-17

Display Devices & Options .......................................1-18
Power Options ..............................................................1-19

Storage Devices, Mouse, Audio & 
Printer
Overview ........................................................................2-1
Hard Disk Drive .............................................................2-2
Optical Device ...............................................................2-3

Loading Discs ..............................................................2-3
Handling CDs or DVDs ...............................................2-4
DVD Regional Codes ..................................................2-5

7-in-1 Card Reader .........................................................2-6
ExpressCard Slot ............................................................2-7
Game Keys .....................................................................2-8
TouchPad and Buttons/Mouse .......................................2-9
XV



Preface
Audio Features .............................................................2-10
Setup for Audio Recording .......................................2-11
Setup for 5.1 Surround Sound ..................................2-12
Sound Effects Equalizer ...........................................2-14

Adding a Printer ...........................................................2-15
USB Printer ...............................................................2-15
Install Instructions: ...................................................2-15

Parallel Printer ...........................................................2-15

Power Management
Overview ........................................................................3-1
The Power Sources ........................................................3-2

AC/DC Adapter ...........................................................3-2
Battery .........................................................................3-2

Turning on the Computer ...............................................3-3
Power Plans ...................................................................3-4
Power-Saving States ......................................................3-6

Sleep ...........................................................................3-6
Hibernate ....................................................................3-7
Shut Down ..................................................................3-7

Configuring the Power Buttons .....................................3-8
Resuming Operation ...................................................3-9

Battery Information .....................................................3-10
Battery Power ...........................................................3-10

Conserving Battery Power ...........................................3-11

Battery Life ..................................................................3-12
New Battery ..............................................................3-12

Recharging the Battery with the AC/DC Adapter .....3-12
Proper handling of the Battery Pack .........................3-13

Battery FAQ ..............................................................3-14

Drivers & Utilities
RAID & AHCI Setup ..................................................4-1

What to Install ................................................................4-1
Module Driver Installation ..........................................4-1

Driver Installation ..........................................................4-2
Manual Driver Installation ...........................................4-3
Updating/Reinstalling Individual Drivers ...................4-4
User Account Control (Win Vista) ..............................4-4
Windows Security Message .........................................4-4
New Hardware Found ..................................................4-4
Driver Installation Procedure .......................................4-5
Chipset ........................................................................4-5
Video ..........................................................................4-5
Audio (Beta Version) .................................................4-6
Audio (Drivers Installer Version) ...............................4-6
TouchPad ....................................................................4-6
Card Reader/ExpressCard ..........................................4-6
GameKey Utility ........................................................4-6
Hot Key (Beta Version) ..............................................4-7
XVI



Preface
Hot Key ......................................................................4-7
IEEE 1394 Filter Driver .............................................4-7

Optional Drivers ..........................................................4-8
Wireless LAN .............................................................4-9
PC Camera ..................................................................4-9
Consumer Infrared (for TV Tuner Remote) ...............4-9
Fingerprint Reader Module ........................................4-9

BIOS Utilities
Overview ........................................................................5-1
The Power-On Self Test (POST) ...................................5-2

Failing the POST .........................................................5-3
Fatal Errors .................................................................5-3
Non-Fatal Errors .........................................................5-3

The Setup Utility ............................................................5-4
Entering Setup .............................................................5-4
Setup Screens ...............................................................5-5

Main Menu .....................................................................5-6
System Time & Date (Main Menu) ...............................5-6
System/Extended Memory: (Main Menu) .....................5-7
BIOS Revision/VGA Card etc. (Main Menu) ...............5-7
Advanced Menu .............................................................5-8
Installed O/S (Advanced Menu) ....................................5-8
SATA Mode Selection (Advanced Menu) ....................5-9
Legacy USB Support: (Advanced Menu) ......................5-9

Boot-time Diagnostic Screen: (Advanced Menu) ..........5-9
Power On Boot Beep (Advanced Menu) .......................5-9
Battery Low Alarm Beep: (Advanced Menu) ................5-9
Security Menu ..............................................................5-10
Set Supervisor Password (Security Menu) ..................5-10
Set User Password (Security Menu) ............................5-11
Password on boot (Security Menu) ..............................5-11
Boot Menu ...................................................................5-12
Exit Menu ....................................................................5-13

Upgrading The Computer
Overview ........................................................................6-1

When Not to Upgrade ..................................................6-2
Removing the Battery ....................................................6-3
Upgrading the Hard Disk Drive .....................................6-4
Upgrading the System Memory (RAM) ........................6-8
Upgrading the Optical (CD/DVD) Device ..................6-13
Upgrading the Video Card ...........................................6-14

Modules
Overview ........................................................................7-1
Setting Up SATA RAID or AHCI Modes .....................7-2

AHCI Mode ................................................................7-2
RAID ..........................................................................7-2

RAID Setup ....................................................................7-3
XVII



Preface
RAID Mode Setup .......................................................7-5
The NVIDIA Storage Control Panel ........................7-12

Bluetooth Module ........................................................7-16
Bluetooth Configuration in Windows Vista .............7-17

Wireless LAN Module .................................................7-20
Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n) 
Driver Installation .....................................................7-21
802.11b/g Driver Installation ....................................7-21

Connecting to a Wireless Network ............................7-22
Intel® My WiFi Installation & Configuration ..........7-25
Intel® Wi-Fi Link 5100/5300 Series My WiFi 
Driver Installation .....................................................7-26

Windows Mobility Center .........................................7-37
PC Camera Module ......................................................7-38

PC Camera Driver Installation .................................7-38
PC Camera Audio Setup ...........................................7-39

TV Tuner Module ........................................................7-45
Consumer Infrared Driver ........................................7-46
Digital TV Broadcast Signal ....................................7-47
TV Recording and Power Plans ...............................7-47
Remote Control Unit ................................................7-47

Fingerprint Reader Module ..........................................7-48
Fingerprint Reader Driver Installation .....................7-49
User Enrollment ........................................................7-50
Fingerprint Control Center Features .........................7-53

Troubleshooting
Overview ........................................................................8-1
Basic Hints and Tips ......................................................8-2
Backup and General Maintenance .................................8-3
Viruses ...........................................................................8-4
Upgrading and Adding New Hardware/Software ..........8-5
Problems & Possible Solutions ......................................8-7
Screen Resolution Error ...............................................8-15

Interface (Ports & Jacks)
Overview .......................................................................A-1
Ports and Jacks ..............................................................A-2
Card Reader ..................................................................A-2
Cable (CATV) ...............................................................A-2
Antenna Jack .................................................................A-2
Consumer Infrared Transceiver ....................................A-2
DC-In Jack ....................................................................A-2
DVI-Out Port ................................................................A-2
e-SATA/USB Port ........................................................A-3
HDMI-Out Port .............................................................A-3
Headphone-Out Jack .....................................................A-3
Line-In Jack ..................................................................A-4
Microphone-In Jack ......................................................A-4
Mini-IEEE 1394 Port ....................................................A-4
RJ-45 LAN Jack ............................................................A-4
XVIII



Preface
S/PDIF-Out Jack ...........................................................A-4
Security Lock Slot ........................................................A-5
USB 2.0/1.1 Ports ......................................................... A-5

NVIDIA Video Driver Controls
NVIDIA Video Driver Installation ...............................B-1
NVIDIA Control Panel .................................................B-2
Display Devices ............................................................B-5
Attaching Other Displays .............................................B-6
Display Modes ............................................................B-10
SLI Multi GPU Configuration ....................................B-13
SLI Multi GPU Configuration & Battery Power ........ B-14
Enabling TV Display ..................................................B-15

Specifications
Processor ....................................................................... C-2
Processor (Cont’d) ........................................................ C-2
Core Logic .................................................................... C-2
Display .......................................................................... C-2
Memory ......................................................................... C-2
Video Adapter ............................................................... C-2
BIOS ............................................................................. C-2
Storage .......................................................................... C-3
Keyboard & Pointing Device ........................................ C-3
Card Reader .................................................................. C-3

Interface ........................................................................ C-3
Slots .............................................................................. C-3
Audio ............................................................................ C-3
Security ......................................................................... C-3
Communication ............................................................. C-4
Operating System .......................................................... C-4
Power Management ...................................................... C-4
Power ............................................................................ C-4
Physical Dimensions & Weight .................................... C-4
Environmental Spec ...................................................... C-4
Optional ........................................................................ C-4
XIX



Preface
XX



Quick Start Guide 1
Chapter 1: Quick Start Guide
Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
optical device, 7-in-1 card reader, ExpressCard/34/54), Game Keys, TouchPad & Mouse, 
Audio Features & Printer.

• Chapter 3 The computer’s power management options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s RAID, Bluetooth, Wireless LAN, PC Camera, TV Tuner and 

Fingerprint modules (some of which may be optional depending on your purchase configuration).
• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the NVIDIA Video driver controls.
• Appendix C The computer’s specification.
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “Drivers & Utilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer”
on page 6 - 1 in the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in this Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the

 symbol. Also please note the safety and handling instructions as indicated in the Preface.

Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features. 
1 - 2 Overview
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Not Included
Operating Systems (e.g. Windows Vista etc.) and applications (e.g. word processing, spreadsheet and database
programs) have their own manuals, so please consult the appropriate manuals.

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component
e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4
- 3. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your
system hasn’t been properly configured (your service representative may have already done that for you), refer to “Drivers
& Utilities” on page 4 - 1 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to com-
municate with external devices, connect to the internet etc.
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System Software
Your computer may already come with system software pre-installed. Where this is
not the case, or where you are re-configuring your computer for a different system,
you will find the Windows Vista (with Service Pack 1) operating system is support-
ed.

Note: In order to run Windows Vista without limitations or decreased performance,
your computer requires a minimum 1GB of system memory (RAM).

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the
Windows OS (see “Setting Up SATA RAID or AHCI Modes” on page 7 - 2).

TV Tuner Module 
Support

Note that the TV Tuner
module (factory) option
in Windows Vista is
supported by the Win-
dows Media Center
software which comes
built-in to the Windows
Vista Home Premium
and Ultimate Editions
only. 

If your purchase in-
cludes a TV Tuner op-
tion, and you are re-
configuring your system
for a different system,
you should install either
Windows Home Premi-
um or Ultimate Edi-
tions only.

Windows Vista Service Pack 1

Make sure you install Windows Vista Service Pack 1 (or a Windows Vista version which
includes Service Pack 1) before installing any drivers. Go to the Microsoft website for
download details, or contact your service center.
1 - 4 Overview
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System Startup
1. Remove all packing materials, and place the computer on a stable surface.
2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
3. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an 

outlet, and connect the AC power cord to the AC/DC adapter.
4. Use one hand to raise the lid/LCD to a comfortable viewing angle (it is preferable not to exceed 130 degrees); use 

the other hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the 
computer by the lid/LCD).

5. Raise the lid/LCD to a comfortable viewing angle, and press the power button.

Figure 1 - 1 - Computer with AC/DC Adapter Plugged-In/Opening the Lid/LCD

Shutdown

Note that you should always shut your computer down by choosing the Shut Down command from the Lock Button
Menu in Windows Vista. This will help prevent hard disk or system problems.
System Startup 1 - 5
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System Map: LCD Panel Open & Top ViewFigure 1 - 2 

LCD Panel Open & Top 
View

1. Optional Built-In PC 
Camera

2. LCD
3. LED Status Indicators
4. Touch Sensor 

Instant Keys
5. 8 * Gaming Keys
6. Keyboard
7. TouchPad and 

Buttons
8. Fingerprint Reader 

Module (optional)
9. LED Power Indicators
10. LCD Panel Color 

LED

See Appendix A for a more
detailed description of the
ports & jacks etc.

2

1

6

7
8

4

5

3

9
10

Wireless Device 
Operation Aboard Aircraft

The use of any portable electronic
transmission devices (e.g. WLAN
or Bluetooth) aboard aircraft is usu-
ally prohibited. Make sure any wire-
less modules are OFF if you are
using the computer aboard aircraft.

Use the appropriate function key
combination/Touch Sensor Key to
toggle power to any wireless mod-
ules, and check the indicators to
see if any modules are powered on
or not (see Table 1 - 2, on page 1
- 8).
1 - 6 System Map: LCD Panel Open & Top View
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LED Indicators
The two sets of LED indicators (LED Status Indica-
tors and LED Power Indicators) display helpful in-
formation about the current status of the computer.

Table 1 - 1 - LED Status Indicators

Game Keys
The eight Game Keys on the left of the computer al-
low macros to be configured for common keystrokes
used in applications, as long as the driver is installed.

Figure 1 - 3 - Game Key Configuration

Icon Color Description

Blinking Blue Hard Disk Activity

Blue Number Lock is Activated

Blue Caps Lock is Activated

Blue Scroll Lock is Activated

Green The Computer is On

Blinking
Green The Computer is In Sleep Mode

Orange The Battery is Charging

Blinking 
Orange

The Battery has Reached 
Critically Low Power Status

Green The Battery is Fully Charged
System Map: LCD Panel Open & Top View 1 - 7



Quick Start Guide1

Touch Sensor Instant Keys
Press the Touch Sensor Instant Keys on the computer to toggle the appropriate function on/off. When a module
is powered on the appropriate icon will be highlighted. 

Table 1 - 2 - Touch Sensor Instant Keys

*When enabled, Silent Mode will reduce fan noise and save power consumption. Note this may reduce comput-
er performance.

Icon Description Icon Description

LED Color Toggle (press to toggle 
flashing colors or single color) Wireless LAN Module Power Toggle

PC Camera Module Power Toggle  Activate the Default Internet Browser

Bluetooth Module Power Toggle Sound Effects Equalizer Mode Toggle
(see page 2 - 14)

Toggle *Silent Mode (for power saving)
Visual Indicator Mute Toggle 

Volume Control Slider (move your finger slowly along the slider to 
adjust the system volume)
1 - 8 Touch Sensor Instant Keys
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Keyboard
The keyboard has an embedded numerical keypad for easy numeric data input, and
features function keys to allow you to change operational features instantly. See
Table 1 - 3, on page 1 - 10 for full function key combination details.

Figure 1 - 4 - Keyboard

Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial functions/hot-keys
unique to the system’s
regular keyboard may not
work.

Num Lk & Scr Lk

Hold down the Fn Key
and Scr Lk/Num Lk to en-
able scroll lock/number
lock, and check the LED
indicator for status. 

Numerical 

Play/Pause Key

Function Keys

NumLk & 
ScrLk Keys

Fn Key

 Keypad 

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLk is on.
Keyboard 1 - 9
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Function Keys & Visual Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition to the
basic function key combinations; visual indicators (see the table below) are available when the Hot Key driver is in-
stalled (see “Hot Key” on page 4 - 7). After installing the driver an icon  will appear in the taskbar.

Table 1 - 3 - Function Keys & Visual Indicators

Keys Function/Visual Indicators Keys Function/Visual Indicators

Fn + ~ Play/Pause (in Audio/Video Programs) Fn +F8/F9 Brightness 
Decrease/Increase

Fn + F1 Touchpad Toggle Fn + F10 PC Camera Power 
Toggle

Fn + F2 Turn LCD Backlight Off 
(Press a key to or use Touchpad to turn on) Fn + F11 WLAN Module 

Power Toggle

Fn + F3 Mute Toggle Fn + F12 Bluetooth Module 
Power Toggle

Fn + F4 Sleep Toggle Fn + NumLk Number Lock Toggle

Fn +F5/F6 Volume Decrease/
Increase Fn + ScrLk Scroll Lock Toggle

Fn + F7 Display Toggle
Note: DO NOT use the Fn + F7 key combination to toggle
through display options when SLI is enabled (see “SLI Multi
GPU Configuration” on page B - 13).
1 - 10 Keyboard
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System Map: Front & Rear Views Figure 1 - 5

Front View

1. Color LEDs
2. Speakers
3. LED Power 

Indicators
4. Consumer Infrared 

Transceiver 
(enabled with 
optional TV Tuner 
only)

5. DC-In Jack

See Appendix A for a more
detailed description of the
ports & jacks etc.

2 3

5

2

2

1 1

1 12

4

TV Tuner Module Support

Note that the TV Tuner module options in Windows Vista is supported by the Windows
Media Center software which comes built-in to the Windows Vista Home Premium and
Ultimate Editions only. 

If your purchase includes a TV Tuner option, and you are re-configuring your system for a
different system, you should install either Windows Home Premium or Ultimate Editions
only.
System Map: Front & Rear Views 1 - 11
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System Map: Right ViewFigure 1 - 6

Right View

1. Headphone-In Jack
2. Microphone-In Jack
3. Line-In Jack
4. S/PDIF-Out Jack
5. Cable (CATV) 

Antenna Jack*
6. Combined eSATA/

USB Port
7. USB 2.0 Port
8. Security Lock Slot
9. Power Button

*Enabled with Optional
Mini-PCI TV Tuner Only

See Appendix A for a more
detailed description of the
ports & jacks etc.

1 2

6

4 53 7 8

9

TV Tuner Module Support

Note that the TV Tuner module options in Windows Vista is supported by the Windows
Media Center software which comes built-in to the Windows Vista Home Premium and
Ultimate Editions only. 

If your purchase includes a TV Tuner option, and you are re-configuring your system for a
different system, you should install either Windows Home Premium or Ultimate Editions
only.

USB Ports

Note that the connections to the USB ports only fit one way, do not force them.
1 - 12 System Map: Right View
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System Map: Left View Figure 1 - 7

Left View

1. DVI-Out Port
2. 2 * USB 2.0 Ports
3. RJ-45 LAN Jack
4. HDMI-Out Port
5. 7-in-1 Card Reader
6. ExpressCard Slot
7. Mini-IEEE 1394 Port
8. Optional Device 

Drive Bay

See Appendix A for a more
detailed description of the
ports & jacks etc.

USB Ports

Note that the connec-
tions to the USB ports
only fit one way, do not
force them.

1 2 3 4
5

8
6 7

Mini-IEEE 1394 Port
The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices. Make sure
you install the IEEE 1394 filter driver (see page 4 - 7).

7-in-1 Card Reader
The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick)
MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter)

Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

HDMI-Out Port
Note that the HDMI-Out Port supports video and audio signals to attached external displays
(also see “HDMI Audio Configuration” on page B - 8).
System Map: Left View 1 - 13
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Disk Eject Warning

Don’t try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don’t try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.

Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.
1 - 14 System Map: Left View
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System Map: Bottom View Figure 1 - 8

Bottom View

1. Sub Woofer
2. Fan Outlet/Intake
3. Component Bay 

Cover
4. Battery 

(Secondary HDD 
Bay - HDD3)

5. Primary HDD Bay 
(HDD1 & 2)

See Appendix A for a more
detailed description of the
ports & jacks etc.

Overheating

To prevent your comput-
er from overheating make
sure nothing blocks the
vent(s)/fan intake(s)
while the computer is in
use.

1

2

4 5

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 3 - 10 for full instructions.

3
2 2
System Map: Bottom View 1 - 15
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Windows Vista Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers listed
in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle off Category View.

Figure 1 - 9 - Start Menu & Control Panel

Click here to toggle Category View

 

1 - 16 Windows Vista Start Menu & Control Panel
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Video Features
You can configure display options, from the Display Settings control panel in Windows as long as the appro-
priate video driver is installed. For more detailed video information see “NVIDIA Video Driver Controls” on
page B - 1.To access Display Settings in Windows:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click 

Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution:  (Figure 1 - 10 on page 1 - 18).
4. Click the arrow, and scroll to the preferred setting In Colors: (Figure 1 - 10 on page 1 - 18).
5. Click Advanced Settings (button)  (Figure 1 - 10 on page 1 - 18).
6. Click GeForce..... (tab).
7. Click Start the NVIDIA Control Panel  (Figure 1 - 10 on page 1 - 18) to access the control panel.
8. The NVIDIA Control Panel can also be accessed by right-clicking the desktop, and then clicking NVIDIA 

Control Panel (or from the NVIDIA Control Panel in the Windows control panel).

1
2

3

4

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. This computer features an
NVIDIA Scalable Link Interface (SLI) that improves graphic quality and performance by combining dual NVIDIA GPUs
in a single system for some of the video card options. SLI Configuration needs to be enabled from the NVIDIA Control
Panel (3D Settings > Set SLI Configuration); see “SLI Multi GPU Configuration” on page B - 13. Check with your
service center for the latest details on video cards supported (see “Video Adapter” on page C - 2 for details). SLI Con-
figuration should not be enabled under battery power (see page B - 14).
Video Features 1 - 17
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Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display or
TV (connected to the DVI-Out port/HDMI-Out port) as your display device.

Figure 1 - 10 - Display Settings & NVIDIA Control Panel

Table 1 - 4 - Display Modes Available

NVIDIA Display Mode Description Note

Single One display device is used. Note that SLI 
configuration 
supports only 
Single display.

Clone Both connected displays output the same view

Dualview Both connected displays are treated as separate devices, and act as a virtual desktop

1 2

3

4

1 - 18 Video Features
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Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 16) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change Plan Settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 10.

Figure 1 - 11 - Power Options

Note: Sleep is the default power saving state in Windows Vista
Power Options 1 - 19
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Chapter 2: Storage Devices, Mouse, Audio & 
Printer
Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• Optical Device
• 7-in-1 Card Reader
• ExpressCard Slot
• Game Keys
• Audio Features
• Adding a Printer
Overview 2 - 1
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 Hard Disk Drive
The hard disk drive(s) is(are) used to store your data in the computer. The hard
disk(s) can be taken out to accommodate other 2.5" serial (SATA) hard disk drives
with a height of 9.5 mm. The primary hard disk bay  is accessible from the bottom
of your computer as seen below, and the secondary hard disk bay  is located under
the battery compartment.

The computer can accommodate up to three hard disks (two in the primary bay, and
one in the secondary bay), and these may be configured in RAID or AHCI modes.
Further details on removing and inserting the hard disk are available in “Upgrading
the Hard Disk Drive” on page 6 - 4.

Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

 Figure 2 - 1
Hard Disk Location

1
2

12

2

2 - 2 Hard Disk Drive
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Optical Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the model you purchased (see “Storage” on page C - 3). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “Boot Menu” on page 5 - 12).

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you
are ready to start. The busy indicator  will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency eject hole

 to open the tray.

Sound Volume 
Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting. 

Peripherals must be
connected before you
turn on the system.

 Figure 2 - 2
Optical Device

1

2

3

12 3
Optical Device 2 - 3
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 Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.

CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.
2 - 4 Optical Device
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DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 14.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3
South-East Asia, Taiwan, South 

Korea, The Philippines, Indonesia, 
Hong Kong

4 South & Central America, Mexico, 
Australia, New Zealand

5 N Korea, Russia, Eastern Europe, 
India & Most of Africa

6 China

Table 2 - 1
DVD Regional Coding
Optical Device 2 - 5
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 7-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “Card Reader/ExpressCard” on page 4 - 6).

*Note: The PC adapters are usually supplied with these cards.

Card Reader Cover

Make sure you keep the
cover in the card reader
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the card read-
er.

 Figure 2 - 3
Right View

1. Card Reader

• MMC (MultiMedia Card)
• SD (Secure Digital)
• MS (Memory Stick)
• MS (Memory Stick Pro)

• MS Duo (requires PC adapter*)
• Mini SD (requires PC adapter*)
• RS MMC (requires PC adapter*)

1

2 - 6 7-in-1 Card Reader
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ExpressCard Slot
The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
press Card/54 and 34mm for the ExpressCard/34. Make sure you install the Express-
Card driver (see “Card Reader/ExpressCard” on page 4 - 6).

Inserting and Removing ExpressCards
• Align the ExpressCard with the slot and push it in until it locks into place (as 

pictured in the generic figure below).
• To remove an ExpressCard, simply press the card to eject it.

ExpressCard 
Slot Cover

Make sure you keep the
cover in the Express-
Card slot when not in
use. This will help pre-
vent foreign objects and/
or dust getting in to the
ExpressCard Slot.

 Figure 2 - 4
ExpressCard Slot

1. Express Card 
Slot

1

ExpressCard Slot 2 - 7
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 Game Keys
The eight game hot keys on the left of the computer allow macros to be configured
for common keystrokes used in applications (the keys can assigned macros for any
program, not only games). To configure the keys follow the instructions below
(make sure you have installed the GameKey Utility driver - see “GameKey Utility”
on page 4 - 6).

1. Run the Game Key Configuration program from the desktop icon  (or from 
C:\Program Files (x86)\Chicony\GameKey\GmKeyCfgUtl.exe).

2. Double-click the button  for the appropriate key (it will turn red ).
3. When the button is red  you may then record the keystrokes to be assigned to 

the Game Key.

4. Click OK.
5. Repeat the procedure for the other Game Key if required.
6. Close the Game Key Configuration window.
7. The keystroke order will be repeated with the appropriate button press in any 

application program.

Figure 2 - 5
Game Key 

Configuration
2 - 8 Game Keys
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TouchPad and Buttons/Mouse
The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse.

Install the TouchPad driver (see page 4 - 6) and then double-click the TouchPad
driver icon  in the taskbar to configure the functions. You may then configure the
TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your
preferences. The TouchPad may be toggled on/off by means of the Fn + F1 key
combination.

Mouse Driver

If you are using an exter-
nal mouse your operat-
ing system may be able
to auto-configure your
mouse during its instal-
lation or only enable its
basic functions. Be sure
to check the device’s
user documentation for
details.

 Figure 2 - 6
Mouse Properties
TouchPad and Buttons/Mouse 2 - 9
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 Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the Realtek HD Audio Manager  icon in the taskbar/
control panel (right-click the taskbar icon  to bring up an audio menu). The volume
may also be adjusted by means of the Fn + F5/F6 key combination or by moving
your finger slowly along the Touch Sensor volume control slider (see Table 1 - 2,
on page 1 - 8). 

Sound Volume 
Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to
check the setting.

 Figure 2 - 7
Realtek Audio 

Manager

Right-click the icon 
to access the menu 
above.

See “HDMI Audio Configuration” on page B - 8 for a description of the audio configuration
when connecting an HDMI supported display device.
2 - 10 Audio Features
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Setup for Audio Recording
To record audio sources on your computer at optimum quality follow the instruc-
tions below:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel) 

and make sure you are in Classic View.
2. Click Realtek HD Audio Manager (or right-click the taskbar icon  and select 

Sound Manager).
3. Click Microphone Effects (tab) in Microphone (tab), and then click to select 

Noise Suppression (button), or adjust the Recording Volume level to around 60, 
to obtain the optimum recording quality.

4. Click OK to close the control panel and save the settings.

Beam Forming

If your stereo micro-
phone supports Beam
Forming (Directional
Recording), then click
the button to calibrate
the stereo microphone
before recording. 

 Figure 2 - 8
Realtek Audio 

Manager - 
Recording Setup
Audio Features 2 - 11
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 Setup for 5.1 Surround Sound
To setup your system for 5.1 surround sound you will need to connect the audio ca-
bles to the Line-In and Microphone-In jacks.
1. Click Start, and click Control Panel (or point to Settings and click Control Panel) 

and make sure you are in Classic View.
2. Click Realtek HD Audio Manager (or right-click the taskbar icon  and select 

Sound Manager).
3. Click Speakers (tab) and click Speaker Configuration (tab).
4. Select 5.1 Speaker from the Speaker Configuration pull-down menu.

 Figure 2 - 9
Speaker 

Configuration

Auto Popup Dialog

You should enable the
auto popup dialog to au-
tomatically detect when a
device has been
plugged-in. If disabled,
double-click connector
settings  and click the
box to enable the auto
popup detection of
plugged-n devices.

Connector Settings
2 - 12 Audio Features
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5. Plug the front speaker cables into the Headphone-Out Jack.
6. Plug in the other cables (you may require an adapter to connect each cable to the 

appropriate jack e.g a stereo mini to dual RCA adapter) from your speakers as 
follows:

• Line-In Jack = Rear Speaker Out
• Microphone-In Jack = Center/Subwoofer Speaker Out

7. As you plug in each cable a dialog box will pop up (see “Auto Popup Dialog” on 
page 2 - 12).

8. Click to put a tick in the appropriate box according to the speaker plugged-in (e.g. 
Rear Speaker Out), and then click OK to save the setting.

9. Click OK to exit Realtek HD Audio Manager. 

 Figure 2 - 10
Connected Device 

Auto Popup
Audio Features 2 - 13
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 Sound Effects Equalizer
Press the  Sound Effects Equalizer Mode Toggle button to toggle through
some of the equalizer options (an on-screen icon will appear to show the selected
mode). A more comprehensive list of options is available from the Equalizer drop-
down list.
1. Click Start, and click Control Panel (or point to Settings and click Control Panel) 

and make sure you are in Classic View.
2. Click Realtek HD Audio Manager (or right-click the taskbar icon  and select 

Sound Manager).
3. Click Digital Output (tab), click Sound Effects (tab) and then click to select an 

option in the Equalizer drop-box.
4. Click OK to close the control panel and save the settings.

 Figure 2 - 11
Realtek Audio 

Manager - 
Recording Setup
2 - 14 Audio Features
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Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most new printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-

tridge etc.). 
2. Turn ON the computer.
3. Turn ON the printer. 
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you 

to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar
(you will need to purchase a parallel to USB converter).

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer’s
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
Adding a Printer 2 - 15
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Chapter 3: Power Management
Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system.

This chapter covers:

• The Power Sources
• Turning on the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.

OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

(Note: All pictures used
on the following pages
are from the Windows
Vista OS.)

Hibernate Mode In 
Windows Vista SP1

If you are using Win-
dows Vista SP1 with
4GB RAM installed, see
page 8 - 13 for informa-
tion on Hibernate.
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components (see page C - 4).

1. Attach the AC/DC adapter to the DC-In jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page 3 - 14).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 10.
3 - 2 The Power Sources
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Turning on the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Sleep/Hibernate hot-
key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down). Use Power Op-
tions (Hardware and Sound menu) control panel in Windows Vista to configure
this feature.

Shut Down

Note that you should al-
ways shut your comput-
er down by choosing the
Shut Down command
from the Lock Button
Menu in Windows Vis-
ta. This will help prevent
hard disk or system
problems.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow-
er button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep

Sleep is the default power mode when the power button is pressed for less than 4 seconds.
You may configure the options for the power button from the Power Options (Hardware
and Sound menu) control panel in Windows Vista (see your OS’s documentation, or
“Configuring the Power Buttons” on page 3 - 8 for details).
Turning on the Computer 3 - 3
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

Resuming 
Operation

See Table 3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

 Figure 3 - 1
Power Plan 

Advanced Settings
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Each Windows Power Plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

 Figure 3 - 2
Power Plans
Power Plans 3 - 5
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Sleep is the default power-saving state in Windows Vista.

Earlier versions of Windows used Stand By and Hibernate as system power-saving
states. Windows Vista combines the features of Stand By and Hibernate into the de-
fault Sleep power-saving state.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

Power Button

The Power Button 
in the Start Menu (in
Classic View use the
Shut Down button )
can be used to send the
computer into a power-
saving state.

Sleep Mode & 
Mobile PC Battery

A mobile PC in Sleep
uses very little battery
power.

After an extended peri-
od of time the computer
will save any open docu-
ments and applications
to hard disk.
3 - 6 Power-Saving States
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut Down
You should shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from shut down takes longer than
from Sleep or Hibernate.

Silent Mode

You can use Silent
Mode to reduce power
consumption and fan
noise. Use the Silent
Mode Touch Sensor In-
stant Key  to toggle
this mode on/off.

On screen visual indica-
tors  and the
Touch Sensor Instant
Key  will display the
Silent Mode status (see
Table 1 - 2, on page 1 -
8).

Note Silent Mode may
reduce computer perfor-
mance.

Figure 3 - 3
Lock Button menu
Power-Saving States 3 - 7
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to a power-saving state.Password 

Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 4
Power Options 
Define Power 

Buttons
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key Combo)

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/Touchpad

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table 3 - 1
Resuming 
Operation

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate hot-key but-
ton when it is pressed for less than 4 seconds (pressing and holding the power button for
longer than this will force shut the computer to shut down).
Configuring the Power Buttons 3 - 9
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon  in the taskbar to see the current battery level and charge
status. 

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

 Figure 3 - 5
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.

Windows Mobility 
Center

The Windows Mobility
Center control panel
provides an easy point
of access for information
on battery status, power
plans used etc.

Figure 3 - 6
Windows Mobility 

Center
Conserving Battery Power 3 - 11
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 7 for information on the battery charge status, and to “Battery In-
formation” on page 3 - 10 for more information on how to maintain and properly
recharge the battery pack.)
3 - 12 Battery Life
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances.
• DO NOT expose the battery to fire or high temperatures, it may explode.
• DO NOT connect the metal terminals (+, -) to each other.

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.
Battery Life 3 - 13
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after saving it) and click Change advanced power 

settings.

 Figure 3 - 7
Power Plan Create
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

• Low battery levels = 0%
• Critical battery Levels = 0%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

 Figure 3 - 8
Power Options 

Advanced Settings - 
Battery
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

SLI Multi GPU Configuration & Battery Power

Note that due to the high power and system demands created by enabling SLI Configura-
tion, you should not enable SLI configuration if your computer is powered by battery
only. If you attempt to run an SLI configuration when the computer is powered by the bat-
tery only, then system problems may occur.

If the computer is currently powered by battery only do not enable SLI configuration. 

If you have currently enabled SLI configuration, and the computer is powered by the AC/
DC adapter, do not switch to battery power only (or go to the NVIDIA Control Panel and
disable SLI configuration before switching to battery power only).
3 - 16 Battery Life



Drivers & Utilities

4

Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities.

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to
be done prior to installing the Windows OS, and there-
fore before installing the other drivers listed here (see
“Setting Up SATA RAID or AHCI Modes” on page 7
- 35).

What to Install
The Device Drivers & Utilities + User’s Manual disc
contains the drivers and utilities necessary for the
proper operation of the computer.

Table 4 - 1, on page 4 - 3 lists what you need to install
and it is very important that the drivers are in-
stalled in the order indicated.

Module Driver Installation
The procedures for installing drivers for the WLAN,
PC Camera, Consumer Infrared (for TV tuner re-
mote), and Fingerprint modules are provided in
“Modules” on page 7 - 1.
What to Install 4 - 1
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button), or Option Driv-
ers (button) to access the Optional driver menu.

Figure 4 - 1 - Drivers Installer Screen 1

1. Check the driver installation order from Table 4 - 1, 
on page 4 - 3 (the drivers must be installed in 
this order) which is the same as that listed in the 
Drivers Installer menu below.

2. Click to select the driver you wish to install, after 
installing each driver it will become grayed out. If 
you need to reinstall any driver, click the Unlock 
button (you should uninstall the driver first).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

 

Figure 4 - 2 - Drivers Installer Screen 2
4 - 2 Driver Installation
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Table 4 - 1 - Driver Installation

Manual Driver Installation
Click the Browse CD/DVD button in the Drivers In-
staller application and browse to the executable file in
the appropriate driver folder.

Windows Update
After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 -
8 for instructions.

Driver Page

Chipset Page 4 - 5

Video Page 4 - 5

Audio (Drivers Installer Version) Page 4 - 6

TouchPad Page 4 - 6

Card Reader/ExpressCard Page 4 - 6

GameKey Utility Page 4 - 6

Hot Key Page 4 - 7

IEEE 1394 Filter Driver Page 4 - 7

Wireless LAN Module Page 7 - 21

PC Camera Module Page 7 - 38

TV Tuner Module Page 7 - 46

Fingerprint Reader Module Page 7 - 49

Windows Vista Service Pack 1

Make sure you install Windows Vista Service Pack 1
(or a Windows Vista version which includes Service
Pack 1) before installing any drivers. Go to the Micro-
soft website for download details, or contact your service
center.
Driver Installation 4 - 3
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Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and 
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue/Al-
low, and follow the installation procedure as directed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or Install to continue the in-
stallation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.
4 - 4 Driver Installation
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button), or Option Driv-
ers (button) to access the Optional driver menu.

RAID Note: Setting up a RAID, or AHCI mode,
needs to be done prior to installing the Windows OS,
and therefore before installing the other drivers listed
here.

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Next > Next.
3. Click > Yes.
4. Click Next > Next.
5. Click Finish to restart the computer.
6. Click Restart Now to apply the changes to the 

computer.

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

Driver Installation General Guidelines

The driver installation procedure outlined in this
Chapter (and in Chapter 7 Options & Modules),
are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.
Driver Installation 4 - 5
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Audio (Beta Version)
1. If you are in the Drivers Installer list click 

Back to return to the top level of the disc.
2. Click Browse CD.
3. Browse to the following location on the Device 

Drivers & Utilities + User’s Manual disc (note 
that D: is the CD/DVD device drive letter, 
however your system may have designated a 
different device drive letter): D:\Driv-
ers\Beta\Audio\setup.exe.

Audio (Drivers Installer Version)
1. Click 3. Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

TouchPad
1. Click 4.Install Touchpad Driver > Yes. 
2. Click Next > Finish.
3. Click Restart Now to restart the computer.

Card Reader/ExpressCard
1. Click 5.Install Cardreader Driver > Yes.
2. Click Install > Finish.

GameKey Utility
1. Click 6.Install Gamekey Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.
4. See “Game Keys” on page 2 - 9 for configura-

tion instructions.

Audio Drivers

Note that two drivers are provided on the disc for the
Audio system.The driver included in the Drivers In-
staller menu has already received certification for
Windows. A second driver is included (which may
resolve some known issues with the original driver),
which at time of going to press, has not yet received
certification for Windows. Install one of the drivers
as per your preference.
4 - 6 Driver Installation
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Hot Key (Beta Version)
1. If you are in the Drivers Installer list click 

Back to return to the top level of the disc.
2. Click Browse CD.
3. Browse to the following location on the Device 

Drivers & Utilities + User’s Manual disc (note 
that D: is the CD/DVD device drive letter, how-
ever your system may have designated a differ-
ent device drive letter): 
D:\Drivers\Beta\Hotkey\setup.exe.

Hot Key
1. Click 7.Install Hotkey Driver > Yes.
2. Click Next > Install.
3. Click Finish to restart your computer.

IEEE 1394 Filter Driver
1. Click 8.Install 1394 Filter Driver > Yes.
2. Click Install > Finish.

Hot Key Drivers

Note that two drivers are provided on the disc for the
Hot Key utility.The driver included in the Drivers In-
staller menu has already received certification for
Windows. A second driver is included (which may
resolve some known issues with the original driver),
which at time of going to press, has not yet received
certification for Windows. Install one of the drivers
as per your preference.
Driver Installation 4 - 7
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Optional Drivers
See the pages indicated for the driver installation pro-
cedures for any modules included in your purchase op-
tion.

Figure 4 - 3 - Optional Drivers Installer Screen

Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Click Check for updates (Security), or double-
click Security Center and click Windows Update.

3. Double-click Check for updates (button).
4. The computer will now check for updates (you 

need to be connected to the internet).
5. Click Install now (button) to install the updates.
4 - 8 Driver Installation
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RAID Setup
Note: Prior to setting up the RAID you will need to use
an operable computer to copy the RAID driver to a
USB flash drive before installing the Windows Vista
operating system. See “Setting Up SATA RAID or
AHCI Modes” on page 7 - 2 for configuration instruc-
tions.

Bluetooth Module
Note: The operating system is the default setting for
Bluetooth control in Windows Vista, and does not re-
quire a driver. See “Bluetooth Module” on page 7 - 16
for configuration instructions.

Wireless LAN
See the appropriate install procedure for your WLAN
module in “Wireless LAN Module” on page 7 - 20.

PC Camera
See the install procedure in “PC Camera Module” on
page 7 - 38.

Consumer Infrared (for TV Tuner Remote)
See the install procedure in “TV Tuner Module” on
page 7 - 45.

Fingerprint Reader Module
See the install procedure in “Fingerprint Reader
Module” on page 7 - 48.
Driver Installation 4 - 9
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Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in software: 

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility 
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

BIOS Settings 
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.
Overview 5 - 1
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The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.Enter Setup prompt

appears only during
POST

Note: The POST screen
as pictured is for guide-
line purposes only. 

Figure 5 - 1
POST Screen

Phoenix SecureCore(tm) Desktop

Copyright 1985-2007 Phoenix Technologies Ltd.

All Rights Reserved

BIOS Revision: ********

KBC/EC Firmware Revision: ********

CPU = 1 Processors Detected, Cores per Processor = 2

Intel(R) Core(TM)2 CPU P8700 @ 2.53GHz

600K System RAM Passed

1022M Extended RAM Passed

3072 KB L2 Cache

System BIOS shadowed

Video BIOS shadowed

Fixed Disk 0: FUJITSU MHZ2250BH G2

ATAPI CD-ROM: TSSTcorp CDDVDW TS-L633A

Mouse intialized

Press <F2> to enter SETUP

1
2

3

4

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct
configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.
The Power-On Self Test (POST) 5 - 3
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The Setup Utility
The Phoenix Setup utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen in Figure 5 - 1 on page 5 - 2 is usually present for a
few seconds after you turn on the system. If you get a “Keyboard Error”, (usually
because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.
5 - 4 The Setup Utility
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Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screen to
make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the
screen. If these tools are confusing, press F1 to call up a General Help screen, and
then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.
The Setup Utility 5 - 5
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 2
Main Menu

Mai n Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

<Tab>, <Shift Tab>, or

<Enter> selects field.

Main

System Time: [22:12:05]

System Date: [04/30/2009]

System Memory: 634 KB

Extended Memory: 1022 MB

BIOS Revision: ********

KBC/EC Firmware Revision: ********

1st VGA Card: nVIDIA GTX 280M

2nd VGA Card: nVIDIA GTX 280M

Phoenix SecureCore(tm) Setup Utility
5 - 6 Main Menu
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System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

BIOS Revision/VGA Card etc. (Main Menu)
This item contains information on the BIOS version and video card etc., and is not
user configurable.
Main Menu 5 - 7
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Advanced Menu

Installed O/S (Advanced Menu)
This setting tells the computer what kind of operating system you’re using. Make
sure you choose the correct setting for your O/S in order to prevent system problems.
Note: If you select the Vista O/S then the SATA Mode Selection menu will become
available.

Figure 5 - 3
Advanced Menu

Main AAdvanced Security Boot Exit

F1 Help �� Select Item - / + Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Select Items To

Enable/Disable

integrated devices

Phoenix SecureCore(tm) Setup Utility

Installed O/S: [Windows VISTA]

SATA Mode Selection: [AHCI]

Legacy USB Support: [Enabled]

Boot-time Diagnostic Screen: [Disabled]

Power On Boot Beep [Disabled]

Battery Low Alarm Beep: [Disabled]

Only available if Windows Vista
is selected as the O/S.
5 - 8 Advanced Menu
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SATA Mode Selection (Advanced Menu)
This menu is only available if you select the Vista O/S as your operating system.
You may enable/disable SATA RAID or AHCI mode for your hard disks, however
you should only enable/disable SATA RAID or AHCI BEFORE installing an
operating system, and after you have backed up all necessary files and data (see
sidebar).

Legacy USB Support: (Advanced Menu)
Choose “Enabled” if you intend to use USB devices in systems which do not nor-
mally support USB functionality (e.g. DOS). The default setting is “Enabled” and
does not need to be changed if you intend to use your USB devices in Windows.

Boot-time Diagnostic Screen: (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep: (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.

SATA Mode 
Selection

If you have installed the
Windows Vista operat-
ing system with either
AHCI or RAID mode en-
abled, DO NOT disable
the set mode (if you wish
to disable the set mode
you will need to reinstall
the Windows VIsta OS).
Advanced Menu 5 - 9
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Phoenix SecureCore Setup Utility. This
will not affect access to the computer OS (only the Phoenix SecureCore Setup
Utility).

Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your ma-
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.

Figure 5 - 4
Security Menu

Main Advanced SSeeccuurriittyy Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Supervisor Password

controls access to the

setup utility.

Security
=

Supervisor Password Is: Clear

User Password Is: Clear

Set Supervisor Password [Enter]

Set User Password [Enter]

Password on boot: [Disabled]

Phoenix SecureCore(tm) Setup Utility
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Set User Password (Security Menu)
You can set a password for user mode access to the Phoenix SecureCore Setup
Utility. This will not affect access to the computer OS, (only the Setup utility) unless
you choose to set a Password on Boot (see below). Many menu items in the Phoenix
SecureCore Setup Utility cannot be modified in user mode. You can only set the
user password after you have set the supervisor password.

Password on boot (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”. 

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
Security Menu 5 - 11
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows
Vista) from the devices listed in this menu, and in this priority order. If it cannot
find the operating system on that device, it will try to load it from the next device in
the order specified in the Boot priority order. Item specific help on the right is
available to help you move devices up and down the order.

Figure 5 - 5
Boot Menu

Phoenix SecureCore(tm) Setup Utility

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Keys used to view or

configure devices:

Up and Down arrows

select a device.

<+> and <-> moves

the device up or down.

<x> exclude or include

the device to boot.

Boot priority order:
1: USB HDD:
2: PCI BEV: P1-TSSTcorp CDDVDW TS-L633
3: PCI SCSI: P0-FUJITSU MHY2120BH
4: PCI SCSI: P4-FUJITSU MHZ2250BH G2
5: PCI BEV: NVIDIA Boot Agent 253.0543
6: USB KEY:
7:
8:

Excluded from boot order:
: USB FDC:
: USB CDROM:

Main Advanced Security Boot Exit
5 - 12 Boot Menu
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Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

Figure 5 - 6
Exit Menu

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Exit System Setup and

save your changes to

CMOS.

Exit Saving Changes

Exit Discarding Changes

Load Setup Defaults

Discard Changes

Save Changes

Main Advanced Security Boot Exit

Phoenix SecureCore(tm) Setup Utility
Exit Menu 5 - 13



BIOS Utilities

5

5 - 14



Upgrading The Computer

6

Chapter 6: Upgrading The Computer
Overview
This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problems you can con-
tact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk Drive
• Upgrading the System Memory (RAM)
• Upgrading the Optical (CD/DVD) Device
Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 6 - 1
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.

Power Safety Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.
6 - 2 Overview
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.
1. Turn the computer off and turn it over.
2. Loosen screws  -  and carefully lift the battery  up.
3. Remove the battery from the battery bay.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 1
Battery Removal

1 3 4

1

4
4

2 3
Removing the Battery 6 - 3
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Upgrading the Hard Disk Drive
The hard disk drive(s) can be taken out to accommodate other 2.5" serial (SATA)
hard disk drives with a height of 9.5mm (h) (see “Storage” on page C - 3). Follow
your operating system’s installation instructions, and install all necessary drivers
and utilities (as outlined in “Drivers & Utilities” on page 4 - 1), when setting up a
new hard disk.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws  & .

HDD System Warning

New HDD’s are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Figure 6 - 2
Component Bay 
Cover Screws

1 2

1 2
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3. Remove the hard disk bay cover . 
4. Remove screws  -  from the hard disk assembly.
5. Remove the hard disk assembly by pulling the tab to disconnect it from the 

connector .

3
4 9

10

3

4 5 6

7 8 9
10

Figure 6 - 3
Bay Cover Removal 

& Hard Disk 
Assembly Screws
Upgrading the Hard Disk Drive 6 - 5
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6. Remove screws  -  (depending on how many hard disks you have installed in 
the assembly).

7. Separate the hard disk board  from the case .
8. Separate the hard disk(s)  &  from the case.
9. Reverse the process to install any new hard disk(s).

Figure 6 - 4
Hard Disk(s) 

Removal

11 20

21 22
23 24

13

18

17 16

15

11

12

14

19

20
21

22

23

24
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Removing the Hard Disk in the Secondary HDD Bay
1. Turn off the computer, and turn it over and remove the battery.
2. The secondary hard disk bay is located under the battery compartment.
3. Remove screws  - .
4. Slide the hard disk assembly in the direction of the arrow .
5. Lift the hard disk assembly  out of the compartment.
6. Remove the screws  -  to release the hard disk from the case .
7. Reverse the process to install any new hard disk(s).

Figure 6 - 5
Secondary HDD 

Removal

25 28
29

30
31 34 35

25 26

30

29

2728

31

32

33

3435
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Upgrading the System Memory (RAM)
The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-
DIMM) DDR III (DDR3) type memory modules (see “Memory” on page C - 2).
The total memory size is automatically detected by the POST routine once you turn
on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws  - .

Figure 6 - 6
Component Bay 
Cover Screws

1 5

1

3

2 4 5
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3. Remove screws  &  from the bottom of the computer.

4. Turn the computer over, open the Lid/LCD, and carefully (a cable  is connected 
to the underside of the LED cover module) lift up the LED cover module .

6 7

6 7
Figure 6 - 7

Bottom LED Cover 
Module Screws

Figure 6 - 8
LED Cover Module 

Removal

8
9

8

9
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5. Remove screws  -  from the keyboard.

6. Carefully lift the keyboard up, being careful not to bend the keyboard ribbon cable.
7. Disconnect the keyboard ribbon cable  from the locking collar socket .

Figure 6 - 9
Keyboard Screws

Figure 6 - 10
Disconnect the 

Keyboard Locking 
Collar 

10 14 

1110 1012 13 14

15 16 

15

16
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8. Remove the keyboard  and keyboard shielding plate .

9. Gently pull the two release latches (  & ) on the sides of the memory socket in 
the direction indicated below.

17 18 

18

17

Figure 6 - 11
Bay Cover Removal

Single Memory 
Module Installation

If your computer has a sin-
gle memory module, then in-
sert the module into the
Channel 0 (JDIMM1) sock-
et as shown in Figure 6 -
12.

Figure 6 - 12
RAM Module 

Release Latches

19 20 

19 20
Upgrading the System Memory (RAM) 6 - 11
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10. The RAM module  will pop-up, and you can remove it.

11. Pull the latches to release the second module if necessary.
12. Insert a new module holding it at about a 30° angle and fit the connectors firmly 

into the memory socket.
13. The module’s pin alignment will allow it to only fit one way. Make sure the module 

is seated as far into the socket as it will go. DO NOT FORCE the module; it should 
fit without much pressure.

14. Press the module in and down towards the mainboard until the socket levers click 
into place to secure the module.

15. Replace the cover and screws (see Figure 6 - 8).
16. Restart the computer to allow the BIOS will register the new memory configuration 

as it starts up.

21

21

Figure 6 - 13
RAM Module 

Removal

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

LED Module Cable

Make sure you recon-
nect the LED Module
cable  (see Figure 6
- 8).

8

6 - 12 Upgrading the System Memory (RAM)
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Upgrading the Optical (CD/DVD) Device
1. Locate the hard disk bay cover and remove screws  & .
2. Remove the hard disk bay cover .
3. Remove the screw at point , and use a screwdriver to carefully push out the 

optical device at point .
4. Reverse the process to install any new optical device.

Figure 6 - 14
Removing the CD/

DVD Device

1 2
3

4
5

1 2

3

4

5
5
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Upgrading the Video Card
If you intend to upgrade or add another VGA card follow the procedures outlined
here. However please check with your service representative first to make sure your
computer can support more than one video card, and that you are not going to void
your warranty. Pay careful attention to the alignment of any video card into the slot
on the mainboard.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws  - 
3. Carefully (a fan and cable are attached to the under side of the cover) lift up 

the bay cover.
4. Carefully disconnect the fan cable , and remove the cover .

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 15
Bay Cover Screws & 
Bay Cover Removal

Fan Cable

Make sure you recon-
nect the fan cable 
before screwing down
the bay cover.

6

1 5

6 7

1
3

2 4 5
6

7
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5. Remove screws  -  (two video cards are pictured here) from the video card 
fan(s) and disconnect the fan cable(s)  (if two cards are present).

6. Remove the RAM fan(s) .

8 10
11

Figure 6 - 16
Video Card Fan 

Screws

Caution

The heat sink, and video
card area in general,
contains parts which are
subject to high tempera-
tures. Allow the area
time to cool before re-
moving these parts.

Figure 6 - 17
Video Card Fan 

Removal

12 8 9

10

11

12 12

8 9

10

11

12
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7. Remove screws  -  from the heatsink in the order indicated on the label 
(two video cards are pictured here).

8. Grip the handle  and carefully remove the heatsink .
9. Remove screws  -  from the video card.Caution

The heat sink, and video
card area in general,
contains parts which are
subject to high tempera-
tures. Allow the area
time to cool before re-
moving these parts.

Figure 6 - 18
Heatsink Removal

13 16

17 18
19 21

16

15 13

1416

15 13

14

1717

19

20 21

19

20 21

18 18
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10. Carefully remove the video card .

Caution

The heat sink, and video
card area in general,
contains parts which are
subject to high tempera-
tures. Allow the area
time to cool before re-
moving these parts.

Figure 6 - 19
Video Card Removal

22

22 22
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Installing a New Video Card

1. Prepare to fit the video card into the slot by holding it at about a 30° angle.

2. The card needs to be fully into the slot, and the video card and socket have a 
guide-key and pin which align to allow the card to fit securely.

Contact Warning

Be careful not to touch
the metal pins on the
VGA card’s connecting
edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the
module’s perfor-
mance.

Figure 6 - 20
Video Card 
Insertion
6 - 18 Upgrading the Video Card
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3. Fit the connectors firmly into the socket, straight and evenly.
4. DO NOT attempt to push one end of the card in ahead of the other.

5. The card’s pin alignment will allow it to only fit one way. Make sure the module is 
seated as far into the socket as it will go (none of the gold colored contact 
should be showing). DO NOT FORCE the card; it should fit without much 
pressure.

Figure 6 - 21
Video Card Insertion 

Procedure
Upgrading the Video Card 6 - 19
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6. Secure the card with screws  -  (Figure 6 - 18 on page 6 - 16).
7. Place the heatsink back on the card, and secure the screws in the order indicated 

in Figure 6 - 18 on page 6 - 16.
8. Attach the video card fan and secure with the screws as indicated in Figure 6 - 16 

on page 6 - 15.
9. Reinsert the component bay cover, and secure with the screws as indicated in 

Figure 6 - 15 on page 6 - 14 (make sure you reconnect the fan cable before 
screwing down the bay cover).

19 21
6 - 20 Upgrading the Video Card
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Chapter 7: Modules
Overview
This chapter contains the information on the various modules (some of which are
optional) which may come with your computer, depending on the configuration
purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

• Setting Up SATA RAID or AHCI Modes
• Bluetooth Module
• Wireless LAN Module
• PC Camera Module
• TV Tuner Module
• Fingerprint Reader Module
Overview 7 - 1
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Setting Up SATA RAID or AHCI Modes
AHCI Mode
Advanced Host Controller Interface (AHCI) is an interface specification that allows
the storage driver to enable advanced serial ATA features such as Native Command
Queuing (for maximum hard disk efficiency and performance). AHCI mode can be
supported by one or two hard disks.

RAID
You may use your hard disks (if you have included more than one hard disk in your
purchase option) in combination with Striping (RAID 0) or Mirroring (RAID 1) for
either fault tolerance or performance (see Table 7 - 1, on page 7 - 4). To configure
your system in Striping (RAID 0) or Mirroring (RAID 1) modes you will require at
least two hard disks.

SATA Mode 
Selection

If you have installed the
Windows Vista operat-
ing system with either
AHCI or RAID mode en-
abled, DO NOT disable
the set mode (if you wish
to disable the set mode
you will need to reinstall
the Windows VIsta OS).
7 - 2 Setting Up SATA RAID or AHCI Modes
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RAID Setup
You may use your hard disks (if you have included more than one hard disk in your
purchase option) in combination with Striping (RAID 0) or Mirroring (RAID 1)
or for either fault tolerance or performance (see Table 7 - 1, on page 7 - 4). To con-
figure your system in Striping (RAID 0) or Mirroring (RAID 1) modes you will re-
quire at least two hard disks.

RAID Enable/Disable 
Warning

DO NOT Enable/Disable
the RAID in SATA Mode
Selection in the BIOS un-
less you intend to reinstall
your operating system.
Make sure you have backed
up all your data before doing
so.

Note that if you do not wish
to use the RAID configura-
tion go to the Advanced >
Advanced Chipset Control
menu and set the SATA
Mode Selection item to
AHCI (see Figure 5 - 3 on
page 5 - 8) before install-
ing the operating system.
RAID Setup 7 - 3



Modules

7

To configure the RAID you will need to do the following:

1. Setup the serial hard disks in the computer (this may have already been done for 
you, or see “Upgrading the Hard Disk Drive” on page 6 - 4).

2. Use an operable computer to copy the RAID folder on the Device Drivers & 
Utilities + User’s Manual disc (containing the drivers) to a USB flash drive.

3. Enable the RAID option in the BIOS.
4. Create the array from the MediaShield BIOS Utility.
5. Install the Windows Vista operating system.
6. Install the drivers from the Device Drivers & Utilities + User’s Manual disc.

RAID Level Description

RAID 0
Identical drives reading and writing data in parallel to increase performance. RAID 0 
implements a striped disk array and the data is broken into blocks and each block is 
written to a separate disk drive.

RAID 1

Identical drives in a mirrored configuration used to protect data. Should a drive that is 
part of a mirrored array fail, the mirrored drive (which contains identical data) will 
handle all the data. When a new replacement drive is installed, data to the new drive is 
rebuilt from the mirrored drive to restore fault tolerance.

Table 7 - 1
RAID Levels

Array Types

A Mirrored Array
(RAID 1) provides full
data protection, as
data can simply be
copied from a healthy
disk to a replacement
for any failed disk.

A Striped Array
(RAID 0) is NOT fault-
tolerant. The failure of
one drive will result in
the loss of all data in
the array. It is de-
signed to increase disk
performance by
spreading the I/O load
across the channels
and drives.
7 - 4 RAID Setup
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RAID Mode Setup
1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to the Advanced menu, select “SATA Mode Selection” and press Enter (see 

page 5 - 7).

3. Select “RAID” or “AHCI”.
4. Press Esc and go to the Boot menu.
5. Set the CD/DVD-ROM Drive (make sure the Microsoft Windows OS CD is

inserted) as the first device in the boot order from the Boot menu.
6. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and

press Enter to exit the BIOS and reboot the computer.

Figure 7 - 1
BIOS > Advanced 

(SATA Mode 
Selection)

Main AAdvanced Security Boot Exit

F1 Help �� Select Item - / + Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

Determines how SATA

controller(s) operate.

Note: An incorrect

setting can cause

some operating

systems to display

unexpected behavior.

Phoenix SecureCore(tm) Setup Utility

� Integrated Devices

Installed O/S: [Windows VISTA]

SATA Mode Selection: [RAID]

Legacy USB Support: [Enabled]

Boot-time Diagnostic Screen: [Disabled]

Power On Boot Beep [Disabled]

Battery Low Alarm Beep: [Disabled]

Only available if Windows Vista
is selected as the O/S.
RAID Setup 7 - 5
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7. As the computer boots up you will see the screen below if no disk array is defined 
(press F10 to enter the utility).

8. The MediaShield ROM BIOS Utility will then appear (if you have not previously 
set up an array then you will be presented with the “Define a New Array” menu).

Figure 7 - 2
MediaShield ROM 

BIOS Startup

Figure 7 - 3
MediaShield BIOS 
Define A New Array

MediaShield ROM BIOS 10.0.0.31

Copyright (C) 2008 NVIDIA Corp.

Detecting storage devices...

1 0.1 TSSTcorp CDDVDW TS-L633A

Press F10 to enter RAID setup utility ...

[ �] Add

[ �] Del

[ ESC] Quit [F6] Back [F7] Finish [TAB] Navigate [��] Select [ENTER] Popup

RAID Mode : Mirrored Striping Block: Optimal

Free Disks Array Disks

Port Disk Model Capacity Port Disk Model Capacity

0.0 FUJITSU MHY212 111.79GB

0.2 FUJITSU MHZ225 232.88GB

MediaShield BIOS Mar 31 2008

- Define a New Array -
7 - 6 RAID Setup



Modules

7

9. Press Tab to navigate through the menu options, the up/down arrow keys to 
move up and down the drop-down menus, and Enter to select an option.

10. Any available free hard disks will appear in the menu on the left, and these may be 
moved into (and removed from) the array by means of the left/right arrow keys.

11. Use the “Define a New Array” menu to:

• Select the RAID mode
• Set up the Striping Block
• Specify the hard disks to be included in the RAID Array

Selecting the RAID Mode
The default setting for the RAID Mode is “Mirrored”. This system supports both
“Mirrored” and “Striped” modes.

Assigning Disks
Use the Tab key to move to the Free Disks section and the first disk will be selected.
Use the right arrow key to move the selected disk into the Array Disks section.
Add any further disks to the Array Disks section in the same way.
RAID Setup 7 - 7
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 12. After assigning the RAID Array, press F7.
13. The clear disk data prompt appears.

Figure 7 - 4
MediaShield BIOS 
Disks Assigned to 

Array
[ �] Add

[ �] Del

[ESC] Quit [F6] Back [F7] Finish [TAB] Navigate [��] Select [ENTER] Popup

RAID Mode : Striped Striping Block: Optimal

Free Disks Array Disks

Port Disk Model Capacity Port Disk Model Capacity

0.0 FUJITSU MHY212 111.79GB

0.2 FUJITSU MHZ225 232.88GB

MediaShield BIOS Mar 31 2008

- Define a New Array -

Figure 7 - 5
MediaShield BIOS 

Overwrite Disk 
Data

[ �] Del

[ESC] Quit [F6] Back [F7] Finish [TAB] Navigate [��] Select [ENTER] Popup

RAID Mode : Striped Striping Block: Optimal

Free Disks Array Disks

Po ity

MediaShield BIOS Mar 31 2008

- Define a New Array -

y

GB

GBB

yyrt Disk Model Capacity Port Disk Model Capaci

[ �] Add

p y p

2.0 TOSHIBA MKMM 8032 74.53G

2.1 TOSHIBA MKMM 8032 74.53G

p y p

y

or i

G

G

All data on new (or added) disks may be overwritten. Continue?

[Y] YES [N] NO
7 - 8 RAID Setup
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14. Press Y to clear all drive data, and the Y to clear MBR (Master Boot Record) if 
applicable (note that when you clear the MBR all data will be destroyed).

15. Press B (Set Boot) to make the array bootable (the Boot column should be ticked).

[ �] Del

[ESC] Quit [F6] Back [F7] Finish [TAB] Navigate [��] Select [ENTER] Popup

RAID Mode : Striped Striping Block: Optimal

Free Disks Array Disks

Port Disk Model k Model Capacity

HSU MHY212 111.79GB

HSU MHZ225 232.88GB

MediaShield BIOS Mar 31 2008

- Define a New Array -

H
H

H
H

Capacity Port Dis

[ �] Add

p y

2. 0 TOSOO
2.1 TOS

p y

y

s

S
S

Clear MBR?

[Y] YES [N] NO

Figure 7 - 6
MediaShield BIOS

Clear MBR

MediaShield BIOS Mar 31 2008

- Array List -

Boot Status Vendor Array Size

√ Healthy NVIDIA STRIPE 223.58G

[Ctrl-X] Exit [��] Select [B] Set Boot [N] New Array [ENTER] Detail

Figure 7 - 7
MediaShield BIOS 

Array List
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16. Press Enter to access the Array Detail window which displays information on the 
selected Array.

17. If you want to mark a disk as empty and wipe out all the contents (note that when 
you clear the MBR all data will be destroyed), then press C.

18. Press Y to wipe out all the data, otherwise press N.
19. Press Enter to return to the Array List window, and then press Ctrl + X to exit. 
20. You will now need to install the Windows OS.
21. Insert the Microsoft Windows Vista OS CD into the CD/DVD drive, and connect 

an external USB flash drive to the notebook computer (make sure that the CD/
DVD drive is set as the first device in the "Boot priority order") with.

22. Press a key when you see the message "Press any key to start up from the CD/
Press any key to boot from CD".

23. Windows Vista will prompt you with a Load Driver warning.
24. Click Browse and navigate to the RAID driver location folder on the USB flash 

drive and click OK.

Figure 7 - 8
MediaShield BIOS 

Array Detail

Array 2 : NVIDIA STRIPE 223.58G

- Array Detail -

[R] Rebuild [D] Delete [C] Clear MBR [ENTER] Return

Port Index Disk Model Capacity

0.0 0 FUJITSU MHY2120BH 111.79GB

0.2 1 FUJITSU MHZ2250BH G2 232.88GB

RAID Mode : Striped

Stripe Width : 2 Stripe Block: 64K
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25. Select the NVIDIA nForce RAID Controller:

•  (C:\Raid\x64\nvrd64.inf) - for 64-bit Windows Vista
•  (C:\Raid\x86\nvrd32.inf) - for 32-bit Windows Vista

26. Click Next to continue the Windows Vista installation (see your Windows 
documentation if you need help on installing the Windows OS).

27. Install the drivers as per the instructions in “Drivers & Utilities” on page 4 - 1.
28. Run the Nvidia control panel from Start > Programs/All Programs > NVIDIA 

Corporation > NVIDIA Control Panel > Storage (choose Advanced or Standard).
29. The Storage Control Panel displays information on the arrays you have setup.

Help

Select Help or press F1
to bring up the NVIDIA
Control Panel Help
menu. Select Storage
from the Contents
menu to get help on any
storage topic.

Figure 7 - 9
NVIDIA Control 
Panel Storage
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The NVIDIA Storage Control Panel
The NVIDIA Storage control panel may be used to rebuild, migrate or synchro-
nize the array.

Rebuilding the Array
1. Run the Nvidia control panel from Start > Programs/All Programs > NVIDIA 

Corporation > NVIDIA Control Panel > Storage (choose Advanced or Standard).
2. Click Storage from the left window.
3. Click on Rebuild Array and then click Next and a wizard will take you through the 

necessary steps.
4. Click to select the RAID and click Next.

Rebuilding the 
Array

The wizard will help you
rebuild one of the arrays
member disks and it will
run in the background.
You can continue to use
the computer while the
rebuild is in process, but
it may take up to a day to
complete.

Make sure you turn off
all power-saving set-
tings e.g. Standby or Hi-
bernate when rebuilding
the array as the process
will be suspended while
power-saving modes
are in operation.

Figure 7 - 10
Select RAID

Rebuilding 
Automatically

Rebuilding restores data
to a hard drive from one of
the other drives in the ar-
ray. This will occur auto-
matically if a spare disk is
available.
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5. Select the member disk to rebuild and click Next.

6. Click Finish and the rebuilding task will begin (this may take time but you can still 
work on the system as it is being rebuilt).

7. A Rebuild In Progress pop-up balloon will appear in the taskbar as the rebuild 
progresses.

8. A Rebuild Finished pop-up balloon will appear in the taskbar when the rebuild 
finishes.

9. You can also check the rebuild status from the View Storage Configuration page 
in the NVIDIA Storage Control Panel (see “NVIDIA Control Panel Storage” on 
page 7 - 11).

Figure 7 - 11
Disk Selection
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Synchronizing the Array
1. Run the Nvidia control panel from Start > Programs/All Programs > NVIDIA 

Corporation > NVIDIA Control Panel > Storage (choose Advanced or Standard).
2. Click Storage from the left window.
3. Click on Synchronize Array and then click Next and a wizard will take you 

through the necessary steps.
4. Click to select the RAID and click Next.
5. The Completing the NVIDIA Synchronize Array Wizard will appear and you can 

click Finish to begin the process.
6. A Synchronization Started pop-up balloon will appear in the taskbar as the 

synchronization progresses.
7. A Synchronization Finished pop-up balloon will appear in the taskbar when the 

rebuild finishes.
8. You can also check the synchronization status from the View Storage 

Configuration page in the NVIDIA Storage Control Panel (see “NVIDIA Control 
Panel Storage” on page 7 - 11).
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Migrating the Array
1. Run the Nvidia control panel from Start > Programs/All Programs > NVIDIA 

Corporation > NVIDIA Control Panel > Storage (choose Advanced or Standard).
2. Click Storage from the left window.
3. Click on Migrate Array and then click Next and a wizard will take you through the 

necessary steps.
4. Click to select the RAID and click Next.
5. Select the new RAID mode and click Next.
6. The Completing the NVIDIA Migrate Array Wizard will appear and you can click 

Finish to begin the process.
7. A Migration Started pop-up balloon will appear in the taskbar as the 

synchronization progresses.
8. A Migration Finished pop-up balloon will appear in the taskbar when the rebuild 

finishes.
9. You can also check the migration status from the View Storage Configuration 

page in the NVIDIA Storage Control Panel (see “NVIDIA Control Panel 
Storage” on page 7 - 11).

Migrating the Array

Migrating an array in-
cludes:

Adding disks to an ar-
ray, e.g. changing a 2
disk striping array to a 3
disk striping array.

Changing to a differ-
ent array type, e.g.
changing from a Mir-
rored to Striped array.

Back up your data be-
fore migrating an array
as data loss is possible if
a disk failure occurs.
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Bluetooth Module
The optional Bluetooth module allows you to connect your computer to Bluetooth
enabled devices such as other computers, desktop computers, mobile phones, print-
ers, digital cameras, PDAs, headsets etc. using a short-range radio frequency.

Use the Fn + F12 key combination or Touch Sensor Instant Key to toggle power
to the Bluetooth module. When the Bluetooth module is powered on, the 
LED will be highlighted and the indicator  will briefly be displayed. The op-
erating system’s Bluetooth Devices control panel is used to configure the Bluetooth
settings in Windows Vista, and therefore does not require a driver.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination/Touch Sensor Key
to toggle power to the Blue-
tooth module, and check
the LED to see if the mod-
ule is powered on or not
(see Table 1 - 3, on page 1
- 10/ Table 1 - 2, on page 1
- 8).

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in
one direction only (simultaneous data transfer is not supported). Therefore if you are copying a
file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Blue-
tooth enabled device to your computer until the file transfer process from the computer has been com-
pleted.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use
the key combination (Fn + F12) to power on the Bluetooth module after the computer resumes from
Sleep.
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Bluetooth Configuration in Windows Vista
Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the Fn + F12 key combination to power on the Bluetooth module. 
2. A Bluetooth icon  will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the Bluetooth Devices control 

panel.

• Double-click the icon  to access the Bluetooth Devices control panel.
• Click Start, and click Control Panel (or point to Settings and click Control Panel), and then 

click Bluetooth Devices (Hardware and Sound).
• Click/Right-click the icon  and choose an option from the menu.

Bluetooth Taskbar 
Icon

If you cannot see the
Bluetooth icon in the
taskbar, access the
Bluetooth Devices
control panel. Click Op-
tions (tab), and make
sure that Show Blue-
tooth icon in the notifi-
cation area check box
(Connections) has a
tick inside it.

Note that you will need
to check the LED indica-
tor to see if the module
is powered on or not.

Figure 7 - 12
Bluetooth Devices & 

Click Icon Menu
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To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click Options (tab), and make sure that Allow Bluetooth devices to connect to 

this computer check box (Connections) has a tick inside it.
3. Click Devices (tab), and then click Add.
4. The Add Bluetooth Device Wizard will appear.
5. Click to select “My device is set up and ready to be found”, and then click Next.

6. The Wizard will then search for any available Bluetooth devices within range.
7. Click to select the device you want to communicate with, and click Next.
8. Select an appropriate passkey option and click Next.

9. Click Finish.

Figure 7 - 13
Add Bluetooth 
Device Wizard

Passkey Options

You can allow the sys-
tem to choose a pass-
key for you. You will
then be prompted to
enter the generated
passkey on your Blue-
tooth device.

Figure 7 - 14
Passkey Option
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To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:

• Change the name of the device (click General, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Options, and make sure that Allow Bluetooth devices to find this 

computer check box (Discovery) has a tick inside it.
3. Make sure that Alert me when a new Bluetooth device wants to connect check 

box (Connections) has a tick inside it, if you want to be notified when a Bluetooth 
device wants to connect.

Bluetooth Help

To get help on Bluetooth
configuration and set-
tings, select Help and
Support from the Start
menu. Type Bluetooth in
the Search Help box,
and select an item from
the returned search re-
sults to get more infor-
mation.

Figure 7 - 15
Bluetooth Devices 

Options
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Wireless LAN Module
If you have included an Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n) WLAN
module, or 3rd Party 802.11b/g WLAN module in your purchase option, make sure
that the Wireless LAN module is on before installing the driver.

Use the Fn + F11 key combination or Touch Sensor Instant Key to toggle power
to the Wireless LAN module. When the WLAN module is powered on, the 
LED will be highlighted and the indicator  will briefly be displayed. Make sure
you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3. The operat-
ing system is the default setting for Wireless LAN control in Windows Vista.

The standard driver installation procedure for the Intel® Wi-Fi Link 5100/5300 Se-
ries module is outlined overleaf. If you want to include Intel® My WiFi Technol-
ogy as part of the installation procedure, DO NOT install the driver as per the
instructions overleaf, instead see “Intel® My WiFi Installation & Configuration”
on page 7 - 25.

If you have installed the standard driver (as per the instructions overleaf) and wish
to enable Intel® My WiFi Technology at a later point you will need to reinstall the
driver (choose Unlock from the Drivers Installer menu). Follow the driver installa-
tion procedure and choose Modify from the menu when the option appears, and then
follow the remaining installation instructions in “Intel® My WiFi Installation &
Configuration” on page 7 - 25.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination/Touch Sensor Key
to toggle power to the
WLAN module, and check
the LED to see if the mod-
ule is powered on or not
(see Table 1 - 3, on page 1
- 10/ Table 1 - 2, on page 1
- 8).
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Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n) Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.

1. Make sure the module is powered on, then insert the Device Drivers & Util-
ities + User’s Manual disc into the CD/DVD drive. 

2. Click Option Drivers (button).
3. Click 1.Install Wireless Lan Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Next > Finish.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows Vista (see overleaf).

802.11b/g Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Util-

ities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install Wireless Lan Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish to restart the computer.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows Vista (see overleaf).

Intel(R) PROSet/ 
Wireless

Access the Intel
PROSet Wireless tools
(Statistics and Diagnos-
tic tools) from the Start
menu (Start > Pro-
grams/All Programs >
Intel PROSet). These
tools provide diagnostic
and statistical informa-
tion only (use the WLAN
control in Windows Vis-
ta to connect to a WLAN
access point).
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Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then click Connect to a network (or right-
click the icon , and then click Connect to a network).

2. In the Show list, click to choose Wireless from the drop-down menu.
3. A list of currently available networks will appear.

Figure 7 - 16
Taskbar Menus

Network and 
Sharing Center

You can also use the
Network and Sharing
Center control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 - 17
Connect to a 

Network

Click icon Right-click icon
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4. Click a network, and then click Connect.
5. If you do not see a network you want to connect to, click Set up a connection or 

network (a list of options will appear allowing manual searching, and creating a 
new network).

6. Move the cursor over the taskbar icon  to see the connection status (see below).

Figure 7 - 18
Connecting

Figure 7 - 19
Connection Status
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7. To disconnect from the wireless network you can click the taskbar wireless icon 
, and then select Connect or disconnect to access the network menu, and 

click Disconnect (or right-click the icon , and then click Disconnect from).
Security Enabled 

Networks

You should try to make
sure that any network
you are connecting to is
a secure network.

Connecting to unsecure
networks may allow un-
authorized access to
your computer, docu-
ments, websites and
files etc.

Figure 7 - 20
Disconnecting

Click icon

Right-click icon
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Intel® My WiFi Installation & Configuration
Intel® My WiFi Technology uses your WLAN module to allow you to connect up
to eight other WiFi enabled devices (e.g. digital cameras, other computers, cell
phones, handheld devices etc.) to your computer (similar to Bluetooth), while still
connecting to the Internet through your WiFi wireless connection. Intel® My WiFi
Technology offers greater range and speed than other personal area networks, and
does not require an access point.

Intel® My WiFi Help

To get help on Intel®
My WiFi configuration
and settings, access the
Intel® My WiFi Utility
from the Start menu
(Start > Programs/All
Programs > Intel
PROSet Wireless > Intel
My WiFi Technology), or
by clicking the taskbar
icon . Click the Help
icon  and select
a help topic from the
Contents menu.
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Intel® Wi-Fi Link 5100/5300 Series My WiFi Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.
1. Make sure the module is powered on, then insert the Device Drivers & Util-

ities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install Wireless Lan Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next > Next.
6. Click Custom (button) and click Next.
7. Click Intel(R) My WiFi Technology (button) and select “This feature will 

be installed on local hard drive.”

8. Click Next > Finish.

Intel(R) PROSet/ 
Wireless

Access the Intel
PROSet Wireless tools
(Statistics and Diagnos-
tic tools) from the Start
menu (Start > Pro-
grams/All Programs >
Intel PROSet). These
tools provide diagnostic
and statistical informa-
tion only (use the WLAN
control in Windows Vis-
ta to connect to a WLAN
access point).

Figure 7 - 21
Intel(R) PRO Set
Intel(R) My WiFi 

Technology 
Installation
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Intel® My WiFi Configuration
You can configure the My WiFi settings as follows.

1. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All 
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking 
the taskbar icon .

2. Click Enable  (on the first run of the program there will be no connected 
devices listed).

Figure 7 - 22
Intel® My WiFi 

Utility
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3. Click Start, and click Control Panel (or point to Settings and click Control 
Panel).

4. Click Network and Sharing Center (Network and Internet). 
5. Click Manage Network Connections. 

6. Right-click Intel My WiFi STA (Station) in Network Connections and select 
Properties.

Figure 7 - 23
Network and 

Sharing Center

Figure 7 - 24
Intel My WiFi STA 

Properties 
(Network 

Connections)

Click Manage Network
Connections 

Right-click Intel My WiFi
STA (Station) and select
Properties. 
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7. Click Sharing (tab) and select “Allow other network users to connect through 
this computer’s Internet connection”.

8. Select Intel My WiFi PAN under Home Networking Connection.
9. Click OK.

Figure 7 - 25
Intel WiFi STA 

Properties - 
Sharing

Click “Allow other network
users to connect through
this computer’s Internet
connection”.

Select Intel My WiFi PAN.
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10. A message will appear to inform you that the LAN adapter will be set to use the IP 
address 192.168.0.1.

11. Click Yes to enable Internet Connection Sharing.

12. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All 
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking 
the taskbar icon .

13. Click Profiles .

Figure 7 - 26
IP Address 

Warning

IP Addresses

The Intel® My WiFi de-
fault gateway IP ad-
dress is 192.168.0.1.
DO NOT use this ad-
dress for any Wireless
Access Point (or any
other static IP address
on your network).

Figure 7 - 27
Intel® My WiFi 

Utility
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14. Click Profiles, click Intel Wireless PAN and click Edit.

15. You can change the Profile Name and Network Name to your personal 
preferences in General (tab).

Figure 7 - 28
IP Address 

Warning

Figure 7 - 29
Intel® My WiFi 

Profile Settings - 
General

Profile and Network Names

The Profile Name is the name as
displayed on your computer in the
Network Connections control pan-
el (see Figure 7 - 24 on page 7 -
28).

The Network Name (SSID) is the
name the devices see when they try
to connect to your computer.
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16. Click Security (tab).
17. Change the Security Type to WEP and the Encryption Type to 64bit.
18. Enter a password (5 characters long) in the Passphrase box.
19. Click OK. 

Figure 7 - 30
Intel® My WiFi 

Profile Settings - 
Security
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20. Click Sharing (tab).
21. Make sure Filter Network Traffic and DHCP and DNS Server are Disabled.
22. Click OK. 

Figure 7 - 31
Intel® My WiFi 

Profile Settings - 
Sharing

Set Filter Network
Traffic & DHCP
and DNS Servers
to Disabled.
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23. Click Advanced (tab).
24. Make sure the Default Channel is set to Channel 1, 6 or 11.
25. Click OK. 

Figure 7 - 32
Intel® My WiFi 

Profile Settings - 
Advanced
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26. Double-click Intel My WiFi PAN (Personal Area Network) in Network Connections.
27. Click Details to display the Network Connection Details.

Figure 7 - 33
Intel My WiFi PAN 

Network 
Connection Details 

(Network 
Connections)
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28. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All 
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking 
the taskbar icon .

29. To add a new device follow the instructions in the devices’ user guide for 
connecting to a WiFi network.

30. Click Add New Device in Intel® My WiFi Utility to confirm the security settings 
detail.

Figure 7 - 34
Intel® My WiFi 

Utility 
(Add New Device)
7 - 36 Wireless LAN Module



Modules

7

Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:
1. Click Start, and click Control Panel (or point to Settings and click Control 

Panel).
2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon  to access the network 

menu.

Figure 7 - 35
Windows Mobility 

Center
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PC Camera Module
Before installing the driver, make sure the PC Camera is on. Use the Fn + F11 key
combination or Touch Sensor Instant Key to toggle power to the to the PC Camera
module. When the PC Camera module is powered on, the  LED will be high-
lighted and the indicator  will briefly be displayed. Make sure you install the
drivers in the order indicated in Table 4 - 1, on page 4 - 3.

PC Camera Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 2.Install WebCam Driver > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish to restart the computer.
6. Run the BisonCap application program from the BisonCam shortcut on the 

desktop, or from the BisonCam item in the Start > Programs/All Pro-
grams menu (if the hardware is turned off use the Fn + F10 key combina-
tion or Touch Sensor Instant Key to turn it on again).

Latest PC Camera 
Driver Information

Check the Device Drivers
& Utilities + User’s Manu-
al disc and any accompa-
nying insert pages, for the
latest updated information
on the PC Camera driver,
which may override the in-
formation provided here.

PC Camera Display

The PC Camera applica-
tion software needs to be
run while the default note-
book LCD is the selected
display device.

After a camera picture is
obtained on the default
notebook LCD, you may
then use the Fn + F7 to tog-
gle through the display
modes (give the screen
time to refresh).
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is 

not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to 

the level required.
7. Click OK and close the control panels.
8. Run the BisonCap application program from the Start > Programs/All Programs 

> BisonCam menu.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should 

have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick 

alongside it).
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Figure 7 - 36
Audio Setup for PC 

Camera

Right-click
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BisonCap
BisonCap is a video viewer for general purpose video viewing and testing, and for
capturing video files to .avi format.

1. Run the BisonCap program from the Start > Programs/All Programs > Bison-
Cam menu (it is recommended that you set the capture file before the capture 
process - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page 7 - 39) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the 
video, and press Esc to stop the capture (you can view the file using the Windows 
Media Player).

Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and location before capture (this will help avoid ac-
cidentally overwriting files). Set the name and location then click Open, then set the
"Capture file size:" and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page 7 - 42 in or-
der to save file space, and help prevent system problems.

Pre-Allocating File 
Space

You may pre-allocate
the file size (File > Allo-
cate File Space) for the
capture file in the
BisonCap program.

Pre-allocating space on
the hard disk can im-
prove the capture quali-
ty (particularly of large
capture files), by reduc-
ing the amount of work
the hard disk has to do
in finding space for the
video data as it is being
captured.

See also “Reducing
Video File Size” on
page 7 - 42.
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Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows Vista system requires a minimum of 15GB of free space on
the C: drive system partition. In order to prevent system problems it is recommend-
ed that you save the captured video file to a location other than the C: drive (see “Set
Capture File” on page 7 - 41), limit the file size of the captured video (see “Pre-
Allocating File Space” on page 7 - 41) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to 

reduce the captured file size.
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Eliminating Screen Flicker
If you find that the video screen in the BisonCap program is flickering, you can try
to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure 7 - 37
Video Capture Filter

(Property Page)
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Zoom
The BisonCap program allows you to zoom the camera in and out.

1. Run the BisonCap program.
2. Go to Zoom and select Zoom Out/Zoom In.

Taking Still Pictures
The BisonCap program allows you to take still pictures.

1. Run the BisonCap program.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder  on the 

desktop.

Figure 7 - 38
Zoom/Setting

Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.
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TV Tuner Module
If your purchase configuration includes the optional Hybrid (Analog & Digital)
USB Mini-Card TV Tuner module, you will be supplied with a remote control unit
and appropriate antenna and fittings for the module. Software support for the TV
Tuner module is provided by Windows Media Center in Windows Vista (Home
Premium Edition & Ultimate Edition). In addition a driver is provided on the De-
vice Drivers & Utilities + User’s Manual disc for the remote control supplied with
the TV Tuner.

The optional TV Tuner allows you to watch TV, play music CDs, video conference
and capture still images and video on your PC.

The Cable (CATV) antenna will only be enabled when a TV Tuner module is
installed. Make sure you connect the TV antenna.

TV Antenna

The TV antenna sup-
plied with any TV Tuner
module is intended for
indoor use only. Please
do not use your TV Tun-
er module outdoors.

TV Tuner Remote

Point the remote at the
consumer IR transceiv-
er to change channels
etc.

Figure 7 - 39
TV Tuner Ports/

Jacks
1. Consumer Infra-

red Transceiver
2. CATV Antenna 

Jack2

1
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Consumer Infrared Driver
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 3.Install CIR Driver > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish to restart the computer.

Windows Media Center
1. This TV Tuner module is fully supported by Windows Media Center in 

Windows Vista (Home Premium Edition & Ultimate Edition).
2. Run Windows Media Center directly from the Start menu (Start > Pro-

grams > Windows Media Center).
3. Windows Help and Support provides information on the Windows Media 

Center functions. Click Start  and select Help and Support, and then 
type “Media Center” in the Search Help box and click the magnifying 
glass icon  to bring up the results.

TV Tuner Module 
Support

Note that the TV Tuner
module options in Win-
dows Vista is support-
ed by the Windows
Media Center software
which comes built-in to
the Windows Vista
Home Premium and Ul-
timate Editions only. 

If your purchase in-
cludes a TV Tuner op-
tion, and you are re-
configuring your system
for a different system,
you should install either
Windows Home Premi-
um or Ultimate Edi-
tions only.
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Digital TV Broadcast Signal
The antenna is the most crucial factor in receiving a clear digital terrestrial TV
broadcast signal. The passive antenna provided should provide a clear signal when
placed beside a window. If the signal is not clear then you can purchase an active
antenna (it should also be placed beside a window) to improve the signal. You
should also check with any related government website which provides information
on digital terrestrial TV coverage for your area. Note that (unlike standard analog
TV) if the digital signal is weak then no picture will appear on the TV at all.

TV Recording and Power Plans
If you intend to use the optional TV Tuner to record live TV, then go to the Power
Options control panel and create a power plan (see “Power Plans” on page 3 - 4)
to prevent the power saving options from adjusting the computer’s performance lev-
el.

Remote Control Unit
The remote control unit allows you to remotely start and send the system into a pow-
er saving state, to run Windows Media Center and to navigate the Media Center
menus etc. The remote control unit also gives full control over all TV and video
functions.

CATV Cable Safety

Make sure that your
CATV system installer
has connected the Co-
axial cable shield to the
grounding system of the
building, as close to the
point of cable entry as
practical.

This reminder is provid-
ed to call the CATV sys-
tem installer’s attention
to Article 820-93 of the
NEC (Section 54, Part I
of the Canadian Electri-
cal Code).
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Fingerprint Reader Module
The optional fingerprint reader Protector Suite Software provides a high level
of security for your computer. A further level of security and control is provided in
the BIOS (see “Security Menu” on page 5 - 10).

The fingerprint reader and Protector Suite Software allow you to:
• Access or Lock your computer
• Protect sensitive files
• Display and file your favorite web pages
• Fill in frequently used dialogs
• Run your favorite applications

If you have included the fingerprint reader in your purchase option you will need to
install the driver as per the instructions below. 

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the
fingerprint tutorial. To run the tutorial click Start > Programs/All Programs >
Protector Suite QL > Fingerprint Tutorial after installing the driver.

Password Warning

If you set passwords for
any of the security mod-
ules, NEVER forget your
password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
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Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive. 
2. Click Option Drivers.
3. Click 4.Install FingerPrint Driver > Yes.
4. Click Software Installation.
5. Click Next > Next > Next.
6. Click Finish > Yes to restart the computer.

Help & Manual

Right-click the taskbar icon
 to bring up the menu to

select Help.

Insert the Device Drivers &
Utilities + User’s Manual
disc and click Option Driv-
ers (button). Click Unlock
(button) and then click 4.In-
stall FingerPrint Driver >
Yes.

Click Documentation to
open the folder containing
the manual in.pdf format. 

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Drivers
& Utilities + User’s Manual
disc and click User’s Manu-
al (button), and click Install
Acrobat Reader (button).
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User Enrollment
1. Click Start > Programs/All Programs > Protector Suite QL > User Enrollment, 

or double click the taskbar icon  (click Initialize).
2. On the first run of the program you will be asked to click the button to accept the 

license, and then click OK.
3. Click Next (the enrollment method will automatically be configured).
4. If you have not set a Windows password you will be prompted to do so (note: If 

you have not set a password Protector Suite QL cannot secure access to your 
computer).

5. Click Finish.
6. Click Next.
7. You will then be prompted to enter your Windows password and click Next.
8. Select either to use the fingerprint reader alone for authentication, or choose both 

the fingerprint reader and the Windows password, and then click Next.

Figure 7 - 40
Multifactor
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9. Click Next > Next (if you have the “Run interactive tutorial” tickbox selected you 
will run through the Fingerprint Tutorial).

10. Click Next for each window of the tutorial (you can click the button to “skip 
tutorial” at any time).

11. Click the button above any of the fingers to begin the enrollment process for that 
finger.

12. Swipe the finger five times to enroll that finger.
13. Repeat the process for all the fingers you wish to enroll (see sidebar), and then 

click Next.
14. Click Finish.
15. Click “Help” in the Fingerprint Control Center to get more information on any 

topic.
16. You can also run the Tutorial, or Introduction (to run the product tour video) to 

get more information.

Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure 7 - 41
Fingerprint 
Enrollment
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17. Right-click the taskbar icon  to Start Control Center to allow you to Edit 
Fingerprints, register applications, manage Password Bank, File Safe and 
access the Help menu etc. You can also run the Control Center etc. from the 
Protector Suite QL item in the Programs/All Programs menu.

18. See “Help & Manual” on page 7 - 49 for further details.
19. If you swipe your finger over the reader at any time you can access the Biomenu 

to lock the computer, register websites, access the Personal Safe open the 
Control Center and access the Help menu.

Figure 7 - 42
Control Center & 

Biomenu 
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Fingerprint Control Center Features

Application Launcher
The Application Launcher allows you to register applications to be launched when
assigned to a particular finger. Simply copy the application icon on to one of the reg-
istered fingers and ten click OK to close the application window. Once registered the
application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other set-
tings for web sites etc. 

File Safe
File Safe is an encrypted area assigned on your hard drive that allows you to store
files and folders to be protected by fingerprint protection.

For more information on these and other features simply access “Help” in the Fin-
gerprint Control Center and select the item from the menu on the left.
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Chapter 8: Troubleshooting
Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
Overview 8 - 1



Troubleshooting

8

Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Power Indicators (see “LED Indicators” on page 1 - 7) 
to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Configuring the Power Buttons” on page 3 - 8), the Fn + F4 key combi-
nation, or power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness (see Table 1 - 3, on page 1 - 10).

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive 
when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the 
disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Boot password for the SCU (see “Security Menu” on page 5 - 10).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief 
notes).

Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).

• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.
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• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices 
and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
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Problems & Possible Solutions
Problem Possible Cause - Solution

You turned the power on
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is present
and seated properly (the design of the battery only allows it to go in one way). Make sure there’s
nothing interfering with the battery contacts.

The Battery LED power
indicator , is blinking
orange.

Low Battery. Plug in the AC power source. If the computer doesn’t start up immediately, turn it off
then on again.

You are losing battery
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see “Power
Plans” on page 3 - 4) check its settings. You may also be using an ExpressCard device/USB
device/external device that is drawing a lot of power.

You are attempting to run an SLI configuration on battery power. Due to the high power and
system demands created by enabling SLI Configuration, you should not enable SLI
configuration if your computer is powered by battery only.

Actual battery operating
time is shorter than
expected.

The battery has not been fully discharged before being recharged. Make sure the battery is fully
discharged and recharge it completely before reusing (see “Battery Information” on page 3 -
10).

Check the settings of any active power plan (see “Power Plans” on page 3 - 4).

A peripheral device/USB device is consuming a lot of power. Turn off/remove the unused device
to save power.
Problems & Possible Solutions 8 - 7
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The computer feels too
hot.

Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If this
doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the
computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 15). Make sure
you’re using the correct adapter. 

Make sure that your notebook is completely powered off before putting it into a travel bag (or any
such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan
intakes to be blocked.

Nothing appears on
screen.

The system is in a power saving mode. Toggle the Fn + F4 (see “Configuring the Power
Buttons” on page 3 - 8).
\

The screen controls need to be adjusted. Toggle the screen control Fn + F8/F9 key
combinations. If you’re connected to an external monitor, make sure it’s plugged in and turned
on. You should also check the monitor’s own brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key Fn + F7 combination. If
an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on
the external monitor I
have plugged in and
powered on.

You haven’t installed the video driver and configured it appropriately from the Control Panel. See
“NVIDIA Video Driver Controls” on page B - 1 for instructions on installing and configuring the
video driver.

Problem Possible Cause - Solution
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You forget the boot
password.

If you forget the password, you may have to discharge the battery of the CMOS. Contact your
service representative for help.

The sound cannot be
heard or the volume is
very low.

The volume might be set too low. Check the volume control in the Volume Control Panel in the
Windows taskbar, use the key combination Fn + F5 and F6 or move your finger slowly along the
volume control slider to adjust the system volume (see “Audio Features” on page 2 - 10/
“Touch Sensor Instant Keys” on page 1 - 8) to adjust.

The compact disc
cannot be read.

The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

The compact disc tray
will not open when there
is a disc in the tray.

The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject
hole (see “Loading Discs” on page 2 - 3).

The DVD regional
codes can no longer be
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5.

Problem Possible Cause - Solution

Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
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The TouchPad doesn’t
work.

The Touchpad has been disabled. Press the Touchpad toggle (Fn + F1) key combination (make
sure you have installed the Touchpad driver.

The system freezes or
the screen goes dark.

The system’s power saving features have timed-out. Use the AC/DC adapter, press a key on the
keyboard, or press the sleep (Fn + F4) key combination, or press the power button if no LEDs are
lit.

The system never goes
into a power saving
mode.

Power Options features are not enabled. Go to the Windows Power Options menu and enable
the features you prefer (see “Power-Saving States” on page 3 - 6). Make sure you have
enabled Hibernate mode from the control panel.

The Wireless LAN/
Bluetooth/PC Camera
modules cannot be
detected.

The modules are off. Check the appropriate Touch Sensor indicator to see if the modules are on
or off (see “Touch Sensor Instant Keys” on page 1 - 8). If the LED indicator is not illuminated,
then press the appropriate touch sensor instant key/function key combination in order to enable
the modules.

The Wireless LAN/
Bluetooth/PC Camera
modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have installed the driver
for the appropriate module (see the instructions in Chapter 7 “Modules” for the appropriate
module).

Problem Possible Cause - Solution
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The Hibernate function
has disappeared.

You have a computer with 4GB of RAM and have installed Windows Vista Service Pack 1. This
is a known issue if your computer has 4GB of RAM and is running Windows Vista Service Pack
1. To re-enable Hibernate mode go to the Command Prompt and type the command “powercfg
-h on” (make sure you are logged on as an Administrator):

1. Click Start  (menu button).
2. Type “cmd” in the Start Search box .
3. Double click the Command Prompt  when it appears in the menu.
4. Type “powercfg -h on” in the Command Prompt window.
5. Close the Command Prompt window.
6. The Hibernate function will now be enabled.

When a DVD is played in
Windows Media Player/
Media Center, the audio
track in other languages
(commentaries etc.) is
not clear if connected to
the S/PDIF-Out Jack.

This is an issue with Windows Media Player/Media Center and audio output through the S/PDIF-
Out Jack. We recommend that you use the Power DVD application to play DVDs.

Problem Possible Cause - Solution
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Nothing appears on the
screen when the PC
Camera software is run.

You have selected an external display as the default display device. The PC Camera application
software needs to be run while the default notebook LCD is the selected display device. 
After a camera picture is obtained on the default notebook LCD, you may then use the Fn + F7 to
toggle through the display modes (give the screen time to refresh).
If you have selected an external display as your display device do not run the PC Camera
software application until you have switched back to the notebook LCD.

A file cannot be copied
to/from a connected
Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is supported in one
direction only (simultaneous data transfer is not supported). If you are copying a file from
your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth
enabled device to your computer until the file transfer process from the computer has been
completed

The Bluetooth module is
off after resuming from
Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state.
Use the key combination (Fn + F12) to power on the Bluetooth module after the computer
resumes from Sleep.

No sound can be heard
through an HDMI
connected display
device.

You have not configured the HDMI audio output. See “HDMI Audio Configuration” on page B -
8.

Problem Possible Cause - Solution
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The Hibernate function
has disappeared.

You have a computer with 4GB of RAM and have installed Windows Vista Service Pack 1. This
is a known issue if your computer has 4GB of RAM and is running Windows Vista Service Pack
1. To re-enable Hibernate mode go to the Command Prompt and type the command “powercfg
-h on” (make sure you are logged on as an Administrator):

1. Click Start  (menu button).
2. Type “cmd” in the Start Search box .
3. Double click the Command Prompt  when it appears in the menu.
4. Type “powercfg -h on” in the Command Prompt window.
5. Close the Command Prompt window.
6. The Hibernate function will now be enabled.

Problem Possible Cause - Solution
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Special note for
BurnInTest V5.3 program
issue.

If you are running the “Burn in test v5.3” program with system RAM over 2GB set the RAM test
mode to Multi-Process Torture Test 0-4GB RAM as per the figure below (BurnInTest
Preferences > RAM).

Figure 8 - 1 - BurnInTest Preferences

Problem Possible Cause - Solution
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Screen Resolution Error
If you are experiencing either screen resolution reduction, or screen flickering after resuming from Sleep in
Windows Vista only then follow the instructions below to fix this problem. This error arises in compliance with
Windows Vista policy, which triggers TMM (Transient Multi-Monitor Manager) when the notebook lid (S3) is
closed. TMM disconnects the LCD display from the OS and then adds the LCD display back when the lid is
opened. This may trigger TMM to restore an old display setting which may result in screen flickering or a screen
resolution change. To fix this problem you will need to disable TMM in the OS:

1. Go to the Control Panel in the Windows OS and double-click the Administrative Tools icon (System and 
Maintenance).

2. Double-click Task Scheduler (Schedule Tasks).

Figure 8 - 2 - Control Panel System and Maintenance
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3. Double-click Task Scheduler Library > Microsoft > Windows.
4. Click MobilePC to open the control panel.
5. Right-click TMM and select Disable.

Figure 8 - 3 - TMM Disable
6. Close all the control panels.
8 - 16 Screen Resolution Error
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Appendix A: Interface (Ports & Jacks)
Overview
The following chapter will give a quick description of the ports & jacks which allow your computer to commu-
nicate with external devices, connect to the internet etc.
Interface (Ports & Jacks) A - 1
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Ports and Jacks

Item Description

Card Reader The card reader allows you to use the following digital storage cards:

MMC (MultiMedia Card) RS MMC (requires PC adapter)
SD (Secure Digital) Mini SD (requires PC adapter)
MS (Memory Stick) MS Duo (requires PC adapter)
MS (Memory Stick Pro)

Cable (CATV) 
Antenna Jack

Use this jack to connect a CATV cable if you have included the optional Mini-PCI TV Tuner in
your purchase.

Consumer Infrared 
Transceiver

The consumer infrared transceiver at the front of the computer allows the computer to
communicate with the remote control unit supplied with the optional Mini-PCI TV Tuner.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

DVI-Out Port The DVI-Out (Digital Visual Interface) Port is a video connector interface. This allows you to
connect an external monitor, TV or Flat Panel Display etc. as a display device (see “Attaching
Other Displays” on page B - 6) by means of a DVI cable. If you are using an older type of
monitor you will need to use a converter to convert the signal from DVI to VGA.
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e-SATA/USB Port This is a combined e-SATA (external Serial Advanced Technology Attachment)/ USB 2.0
compatible port.

Plug external Serial ATA hard drives into this e-SATA (external Serial Advanced Technology
Attachment) port. See “USB 2.0/1.1 Ports” on page A - 5 for USB port information.

HDMI-Out Port The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device (see “Attaching Other Displays” on page B - 6) by
means of a HDMI cable. Note that HDMI carries both audio and video signals (see “HDMI
Audio Configuration” on page B - 8).

Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume
to a reduced level before connecting to this jack.

Item Description

e-SATA /

HDMI

HDMI Audio Support

Note that some NVIDIA video card models DO NOT support High Definition Audio through
HDMI. When connecting these video cards to an external display (using an HDMI cable), it
is recommended that you use a third party video application (e.g. Power DVD) that provides
appropriate audio decoding to play DVDs etc. Alternatively you can output audio through an
alternative source to the HDMI connection.
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Line-In Jack The Line-In jack allows you to play audio sources through the computer’s speakers. Note that
audio input through Line-in will default to the mute setting. To set up your audio sources to play
through the Line-in jack go to the Sound  control panel and make sure the Mute box is not
ticked.

Microphone-In Jack Plug an external microphone in to this jack to record on your computer.

Mini-IEEE 1394 Port This allows high-speed connection to various peripheral devices, e.g. external disk drives and
digital cameras (see note below).

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

Item Description

IEEE 1394
The Mini-IEEE 1394 ports only support SELF POWERED IEEE 1394 devices. Make sure
you install the IEEE 1394 filter driver (see page 4 - 7).
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Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

USB 2.0/1.1 Ports These USB (Universal Serial Bus) 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are
for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals
such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be
plugged into the computer, and unplugged from the computer, without the need to turn the
system off (if the power rating of your USB device is 500mA or above, make sure you use the
power supply which comes with the device).

Item Description
Interface (Ports & Jacks) A - 5
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Appendix B: NVIDIA Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 17.

NVIDIA Video Driver Installation
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

1. Insert the Device Drivers & Utilities + User’s Manual disc and click Install 
Drivers (button).

1. Click 2.Install Video Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

Resolution Error

If you are experiencing
screen resolution prob-
lems/screen flickering after
resuming from Sleep in
Windows Vista see page
8 - 15.

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and chang-
es. Check with your service center for the latest details on video cards supported.
NVIDIA Video Driver Installation B - 1
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NVIDIA Control Panel
More advanced video configuration options are provided in the NVIDIA Control
Panel tab.

1. Open the Display Settings (see page 1 - 18) control panel.
2. Click Advanced Settings (button).
3. Click GeForce..... (tab).
4. Click Start the NVIDIA Control Panel to make any video adjustments.

OR
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the

menu if you are in Control Panel Home).

NVIDIA Control 
Panel 

To access the Ge-
Force..... control panel
from the desktop; right-
click the desktop, then
click NVIDIA Control
Panel.

Figure B - 1
NVIDIA GeForce..... 

Control Panel
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The NVIDIA Control Panel provides additional video configuration controls and
tools which allow quick access to features such as display configuration, 3D Settings
and Help menus etc. Navigating the 

Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.
Click on the sub-head-
ing tasks in the left
menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

Figure B - 2
NVIDIA Control 

Panels
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The Help menus provide index and search features, and direct links to the NVIDIA
website etc.

Figure B - 3
Help Menus
B - 4 NVIDIA Control Panel
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Display Devices
Note that you can use a DVI cable connected to the DVI-Out port, or an HDMI
(High-Definition Multimedia Interface) cable connected to the HDMI-Out port to
connect an external display (if you are using an older type of monitor you can use a
converter to convert the signal from DVI to VGA). See your display device manual
to see which formats are supported.

1. The built-in LCD.
2. An external display connected to the DVI-Out Port.
3. An external display/TV (if the TV supports an HDMI connection) connected to the

HDMI-Out Port.

Display Devices

Besides the built-in
LCD, you can also use
an external monitor/flat
panel display as your
display device. The dis-
play options are:

• The built-in LCD.
• An external display 

connected to the DVI-
Out port.

• An external display 
connected to the 
HDMI-Out port.

Note that HDMI sup-
ports video and audio
signals.

DO NOT use the Fn +
F7 key combination to
toggle through display
options when SLI is en-
abled.

Monitor and TV Tuner

If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aeri-
al to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tun-
er first, then the monitor.
Display Devices B - 5
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Attaching Other Displays
Configuring an External Display in Windows Vista
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click on any of the buttons to configure the displays to your preferences, or click
Display Settings (in the New Display Detected window) to access the control
panel.

Figure B - 4
New Display 

Detected
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Configuring an External Display using the NVIDIA Control Panel
Alternatively you can use the NVIDIA control panel to configure any attached dis-
plays.
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see “NVIDIA Control Panel” on page  B - 2).
3. Double-click Display, and then click Set up multiple displays.

4. Click to select the nView display mode you wish to use (see page B - 8).
5. Select the display(s) you want to use (if your display is not shown click “My Display

is not shown in the list...”), and choose which display is to be the primary display.
6. Click Apply > Yes to save the changes.

Figure B - 5
Set Up Multiple 

Displays
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HDMI Audio Configuration
As HDMI (High-Definition Multimedia Interface) carries both audio and video sig-
nals you will need to configure the audio output as per the instructions below. The
settings will depend upon the video card you have installed in your purchase option.

Windows Audio Setup for HDMI
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Playback (tab), and click to select Realtek Digital Output or NVIDIA HDMI

Output (see sidebar).
4. Click Set Default (button).
5. Click OK to close the Sound  control panel.
6. You will now be able to hear audio sources when played in Windows Media Player.

 Playback Options

If your video card has
hardware support for
HDMI the NVIDIA HDMI
Output option will be
available, and should be
selected as the play-
back option.

If the NVIDIA HDMI Out-
put does not appear,
then Realtek Digital
Output should be se-
lected as the playback
option.

Figure B - 6
Sound Playback 

Options
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HDMI Notes
• Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-

ing to play audio/video sources through the device.

• If you disconnect the HDMI cable the default audio playback device will not 
revert to speakers until the computer is restarted (if you do not wish to restart the 
computer then go to the Sound control panel and select Speakers as the default 
audio playback device).

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “Configuring an

External Display using the NVIDIA Control Panel” on page B - 7.
3. Set up your external display (TV or LCD) for HDMI input (see your display device

manual).
4. You can now play video/audio sources through your external display.

 Other Applications

If you are using a third
party application to play
DVDs etc. you will need
to consult the applica-
tion’s documentation to
see the appropriate au-
dio configuration (the
application must support
digital to analog transla-
tion).

HDMI Audio Support

Note that some NVIDIA video card models DO NOT support High Definition Audio through
HDMI. When connecting these video cards to an external display (using an HDMI cable), it
is recommended that you use a third party video application (e.g. Power DVD) that provides
appropriate audio decoding to play DVDs etc. Alternatively you can output audio through
an alternative source to the HDMI connection.
Attaching Other Displays B - 9
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Display Modes
Single Display Mode
Only one of your displays is used.

Clone Mode
Clone Mode simply shows an exact copy of the Primary display desktop on the other
display(s). This mode will drive multiple displays with the same content.

Dualview Mode
Dualview Mode (or Extended Mode in Windows Vista - see overleaf) treats both
connected displays as separate devices, and they act as a virtual desktop resulting in
a large workspace. When Dualview is enabled, you can drag any icons or windows
across to the other display desktop. It is therefore possible to have one program vis-
ible in one of the displays, and a different program visible in the other display.

SLI Configuration & 
Multiple Displays

Note that if SLI configu-
ration is enabled only a
Single display may be
used as the display de-
vice.

DO NOT use the Fn +
F7 key combination to
toggle through display
options when SLI is en-
abled. SLI supports only
a Single display, and at-
tempting to configure
dual displays may cause
an error. Use the NVID-
IA control panel to select
the display to be used.
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Using New Display Detected to Enable Extended Mode
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click to select Show different parts of my desktop on each display (extended).
4. Click Right or Left under Extend your desktop.
5. Click Apply > OK.

Figure B - 7
New Display 

Detected 
(Extended)
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Using Display Settings to Enable Extended Mode
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Click Start, and click Control Panel (or point to Settings and click Control

Panel).
3. Click Adjust screen resolution under the Appearance and Personalization

menu (or double-click Personalization > Display Settings).
4. Click the monitor icon (e.g. ), and make sure you have checked “Extend the

desktop onto this monitor.” and click Apply.

 Display Settings 
Extended Desktop 

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use.

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Figure B - 8
Display Settings 

(Extend the 
Desktop)

2

Click the appropriate monitor
icon (e.g. ) to be able to select
the option to extend the desktop
on to it.

In this example the Primary mon-
itor  is on the left, the secondary
display  is on the right.

2

1
2
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SLI Multi GPU Configuration
This computer features an NVIDIA Scalable Link Interface (SLI) that improves
graphic quality and performance by combining dual NVIDIA GPUs (two video
cards are required) in a single system. To enable/disable SLI Configuration:
1. Go to NVIDIA Control Panel (see “NVIDIA Control Panel” on page  B - 2).
2. Click “+” next to 3D Settings if its sub-items are not shown and then click Set SLI 

Configuration.

3. Click “Enable SLI technology (recommended)”.
4. Click to “Select the display to view the SLI rendered content on.” (only a single

display may be used).
5. Click Apply and Yes to restart the computer (see over).

SLI Configuration & 
Multiple Displays

Note that if SLI configu-
ration is enabled only a
Single display may be
used as the display de-
vice.

DO NOT use the Fn +
F7 key combination to
toggle through display
options when SLI is en-
abled. SLI supports only
a Single display, and at-
tempting to configure
dual displays may cause
an error. Use the NVID-
IA control panel to select
the display to be used.

Figure B - 9
Set SLI 

Configuration
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SLI Multi GPU Configuration & Battery Power
Note that due to the high power and system demands created by enabling SLI Con-
figuration, you should not enable SLI configuration if your computer is powered
by battery only. If you attempt to run an SLI configuration when the computer is
powered by the battery only, then system problems may occur.

• If the computer is currently powered by battery only do not enable SLI config-
uration. 

• If you have currently enabled SLI configuration, and the computer is powered 
by the AC/DC adapter, do not switch to battery power only (or go to the 
NVIDIA Control Panel and disable SLI configuration before switching to bat-
tery power only).
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Enabling TV Display
To display desktop images on a TV, connect the TV to your computer by using an
HDMI cable/DVI cable from the TV to the HDMI-Out port/DVI-Out port (if sup-
ported by your TV).

You will need to enable the TV display from the NVIDIA Control Panel as per the
instructions on B - 7. The TV will appear as a display option (2. Select the displays
you would like to use.) when attached to the appropriate port. Apply the settings,
and then click Yes to save the changes.

Detect Displays

To get a full range of dis-
play options click “My dis-
play is not shown in the
list...”.

HDMI Audio Setup

See “HDMI Audio Con-
figuration” on page B -
8 for instructions on con-
figuring audio for HDMI
display devices. 

Set up your external dis-
play (TV or LCD) for
HDMI input (see your
display device manual).

Figure B - 10
Set Up Multiple 

Displays 
(with TV connected) 
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Changing the TV Signal Format (Dualview Mode Only)
1. When the TV is enabled as a display device, and Dualview is the selected display 

mode, click the sub-menus under Video & Television.
2. Click “Change the signal or HD format”
3. Select the TV signal format (the menu allows you to select TV format by country if

you are unsure of your TV format).
4. Apply the settings, and then click Yes to save the changes.

Figure B - 11
Change the Signal or 

HD Format
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Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.
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Processor

Intel® Core™ 2 Quad Processor - (478-
pin) Micro-FC-PGA Package, 45nm (45 
Nanometer) Process Technology:
QX93000 - 2.53 GHz, 12MB On-die L2 
Cache & 1066MHz FSB (45W)
X9100 - 2.53GHz, 6MB On-die L2 Cache 
& 1066MHz FSB (44W)
Q9000 - 2.0GHz, 6MB On-die L2 Cache 
& 1066MHz FSB (45W)
Q9100 - 2.26GHz, 12MB On-die L2 
Cache & 1066MHz FSB (45W)

Intel® Core™ 2 Duo Processor - (478-
pin) Micro-FC-PGA Package, 45nm (45 
Nanometer) Process Technology:
T9400 - 2.53 GHz, 6MB On-die L2 Cache 
& 1066MHz FSB (35W)
T9600 - 2.80 GHz, 6MB On-die L2 Cache 
& 1066MHz FSB (35W)
T9800 - 2.93 GHz, 6MB On-die L2 Cache 
& 1066MHz FSB (35W)

Processor (Cont’d)

Intel® Core™ 2 Duo Processor - (478-
pin) Micro-FC-PGA Package, 45nm (45 
Nanometer) Process Technology:
P9500 - 2.66 GHz, 6MB On-die L2 Cache 
& 1066MHz FSB (25W)
P9600 - 2.53 GHz, 6MB On-die L2 Cache 
& 1066MHz FSB (25W)
P8600 - 2.66 GHz, 3MB On-die L2 Cache 
& 1066MHz FSB (25W)
P8700 - 2.53 GHz, 3MB On-die L2 Cache 
& 1066MHz FSB (25W)

Core Logic

MCP79 SLI Chipset

Display

18.4" Full HD (1920 * 1080) TFT LCD

Memory

Two 64-bit wide DDRIII (DDR3) data 
channels
Two 204 Pin SO-DIMM Sockets 
Supporting DDRIII (DDR3) 1066MHz/
1333MHz Memory Modules
Memory Expandable up to 4GB

Video Adapter

nVIDIA® GeForce GTX 280M SLI PCIe 
Video Card
1GB GDDR3 Video RAM On Board
Supports PCIe * 8 (SLI - 2 * PCIe * 8)
Supports Microsoft DirectX® 10.0
Supports HDCP

BIOS

One 8Mb Flash ROM
Phoenix™ BIOS
C - 2 Specifications
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Storage

Up to three (Option) Changeable 2.5" 9.5 
mm (h) SATA (Serial) Hard Disk Drives 
supporting RAID level 0/1
One 12.7 mm Super Multi/Blu-Ray 
Combo/Writer SATA Optical Device Drive 
(Option)

Keyboard & Pointing Device

Full Size Winkey Keyboard with Numeric 
Keypad
Built-In TouchPad (Scroll Functionality 
Included)
Eight Touch Sensor Instant Keys (Color, 
CCD, Bluetooth, WLAN, Internet, Silent 
Mode, Sound Effect, Mute)
Eight Gaming Keys G1 ~ G8

Card Reader

Embedded 7-in-1 Card Reader (MS/ MS 
Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS 
Duo) Note: MS Duo/ Mini SD/ RS MMC 
Cards require a PC adapter

Interface

Four USB 2.0 Ports
One eSATA Port
One DVI-Out Port (with CRT out)
One HDMI (High-Definition Multimedia 
Interface) Port with Audio Output (with 
HDCP Support)
One Headphone/Speaker-Out Jack
One Microphone-In Jack
One Line-In Jack
One S/PDIF Out Jack
One RJ-45 LAN Jack
One Mini-IEEE1394a Port
One DC-In Jack
One Consumer Infrared Port for TV Tuner 
Remote Controller
CATV Jack (for TV Tuner)

Slots

One ExpressCard/34/54 Slot
Two Mini Card Slots:
 Slot 1 for PCIe WLAN Module
 Slot 2 for USB TV Tuner Module

Audio

High Definition Audio3D Stereo 
Enhanced Sound System
S/PDIF Digital Output
Built-In Microphone
5 * Built-In Speakers (2W/ 1.5W, 4Ω)
One Sub Woofer (2W, 4Ω,)
Dolby Surround Supported

Security

Security (Kensington® Type) Lock Slot
BIOS Password
Fingerprint Reader Module (Factory 
Option)
Trusted Platform Module V1.2 (Factory 
Option)
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Communication

Built-In Giga Base-TX Ethernet LAN
Bluetooth 2.1 + EDR (Enhanced Data 
Rate) Module (Factory Option)
Intel® WiFi Link 5300 Series (3*3 - 
802.11a/g/n) Wireless LAN PCIe 
interface Mini-Card Module (Option)
Intel® WiFi Link 5100 Series (1*2 - 
802.11a/g/n) Wireless LAN PCIe 
interface Mini-Card Module (Option)
3rd Party 802.11b/g Wireless LAN PCIe 
interface Mini-Card Module (Option)
2.0M or 3.0M Pixel PC Camera Module 
with USB interface (Factory Option)

Operating System

Windows Vista Home Premium/ 
Business/ Enterprise/ Ultimate
Note that the TV Tuner module (factory) 
option in Windows Vista is supported by 
the Windows Media Center software 
which comes built-in to the Windows 
Vista Home Premium and Ultimate 
Editions only. 

Power Management

Supports Wake on LAN
Supports Wake on USB

Power

Full Range AC/DC Adapter – AC in 100 - 
240V, 50 - 60Hz DC Output 19V, 11.6A or 
19V, 12.2A (220 Watts)
Easy Changeable Polima Smart Lithium-
Ion 4650mAH Main Battery

Physical Dimensions & Weight

439mm (w) * 299mm (d) * 44mm (h)
Around 4.9kg with Battery and ODD

Environmental Spec

Temperature 
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Optional

Super Multi Drive Module
Blu-Ray Combo Drive Module
Intel® WiFi Link 5300/5100 Series (3*3/
1*2 - 802.11a/g/n) Wireless LAN PCIe 
Interface Mini-Card Module
3rd Party 802.11b/g Wireless LAN PCIe 
Interface Mini-Card Module
Bluetooth 2.1 + EDR (Enhanced Data 
Rate) Module (Factory Option)
2.0M or 3.0M Pixel USB 2.0 PC Camera 
Module (Factory Option)
Fingerprint Reader Module (Factory 
Option)
Mini-Card TV Tuner Module with USB 
Interface (Factory Option)
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